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FACULTY OF INFORMATION TECHNOLOGY
DEPARTMENT OF INFORMATION SYSTEMS
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Abstrakt
Komunikace mezi zař́ızeńımi se neobejde bez jasně definovaných pravidel. Tato pravidla
se společně označuj́ı jako komunikačńı protokol. V této práci se zabývám komunikačńımi
protokoly, konkrétně bezpečnostńımi protokoly. Jejich návrh vyžaduje speciálńı nástroje,
které umožňuj́ı simulaci a odhaleńı bezpečnostńıch chyb v jejich návrhu. Zaměřuji se tedy
na nástroje umožňuj́ıćı interaktivńı simulaci bezpečnostńıch protokol̊u. Detailně popisuji
jednotlivé nástroje a srovnávám jejich kladné a záporné vlastnosti. V dostupných nástroj́ıch
implementuji bezpečnostńı protokoly. Výsledem práce jsou demostračńı úlohy využitelné
v śıt’ových předmětech na FIT VUT.

Abstract
Communication between devices should be based on predefined rules. These rules are called
communication protocols. In this master thesis I am concerned with communication proto-
cols, specially security protocols. Their design demands specialized tools, that will provide
interactive simulations and security testing. I have described each of these tools in detail
and mentioned about their properties, their pros and cons. In available tools I have im-
plemented security protocols. The result is set of demonstration tasks that are usable in
network courses at FIT VUT.
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2.1 Bezpečnostné protokoly . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4
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2.5.2 Útok prehrávańım . . . . . . . . . . . . . . . . . . . . . . . . . . . . 11
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5.1.2 Ovládanie . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 28

5.2 SPAN . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 29
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6.1.2 Implementácia Needham-Schroeder Public Key - Lowe . . . . . . . . 38
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6.2 Úloha č.2 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 44
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Kapitola 1

Úvod

Komunikácia medzi elektronickými zariadeniami najrôzneǰśıch druhov od poč́ıtačov cez mo-
bilné telefóny až po platobné terminály je jednou zo základných požiadaviek dnešnej doby.
Prenos informácíı medzi zariadeniami sa však nezaob́ıde bez jasne definovaných pravidiel.
Tieto pravidlá sa spoločne označujú ako komunikačný protokol. Informácie prenášané pomo-
cou týchto protokolov cez siet’ možu mat’ vysokú hodnotu a sú tak terčom útokov. Špeciálnu
oblast’ preto predstavujú bezpečnostné protokoly nasadzované predovšetkým na miestach,
kde vyžadujeme zabezpečenú, šifrovanú komunikáciu. Jedná sa o protokoly prenášajúce cit-
livé informácie napŕıklad platobné pŕıkazy či autentizačné údaje. Návrh, testovanie a sprá-
vne pochopenie komunikačných a bezpečnostných protokolov si vyžaduje špecifické nástroje
a prostredia umožňujúce ich simuláciu. Niektoré nástroje dokážu odhalit’ pŕıpadné chyby
alebo bezpečnostné zranitel’nosti v návrhu.

Ciel’om tejto práce je zoznámit’ sa s prinćıpmi, použit́ım a interakt́ıvnou simuláciou ko-
munikačných protokolov so zamerańım na bezpečnostné protokoly. Na základe źıskaných
poznatkov a pomocou dostupných nástrojov odsimulovat’ vybrané bezpečnostné proto-
koly a k týmto nástrojom naṕısat’ uživatel’skú pŕıručku. Motiváciou je pomocou sady úloh
a pŕıkladov, zoznámit’ čitatel’a s danou problematikou a zároveň vytvorit’ zoznam nástrojov
umožňujúcich interakt́ıvnu simuláciu a demonštrovat’ ich možnosti. Źıskané poznatky môžu
byt’ využité v siet’ových predmetoch na FIT VUT.

V nasledujúcej kapitole sa budem venovat’ teoretickému základu z oblasti protokolov a ich
vlastnost́ı, hlavne bezpečnosti. Stručne poṕı̌sem základné výrazové prostriedky pre popis
protokolov. V tretej kapitole budú uvedené jednotlivé nástroje, ktoré umožňujú ich in-
terakt́ıvnu simuláciu a k týmto nástrojom uvediem hlavné vlastnosti, dostupnost’, detailné
parametre, typ licencie a ciel’ použitia. Na vybraných protokoloch odsimulujem a porovnám
spôsoby implementácie v kapitole štyri a navrhnem sadu demonstračných úloh a pŕıkladov
v kapitole piatej. V záverečnej kapitole zhodnot́ım svoju prácu a źıskané poznatky.
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Kapitola 2

Komunikačné protokoly

V tejto kapitole uvediem teoretický úvod do problematiky komunikačných protokolov obecne
a následne sa zameriam na bezpečnostné protokoly. Spomeniem základné vlastnosti bezpe-
čnostných protokolov ako aj výrazové prostriedky pre ich popis.

Protokoly predstavujú formálnu stránku riadenia komunikácie pretože poskytujú formálny
nástroj na uskutočňovanie vecnej náplne riadenia komunikácie a pomáhajú tak realizo-
vat’ pŕıslušné komunikačné funkcie. Komunikačné protokoly tvoria súhrn pravidiel formátu
a procedúr určujúcich výmenu údajov medzi dvomi komunikujúcimi prvkami [19]. Protokoly
sú implementované hardwarom, softwarom pŕıpadne kombináciou obidvoch. Na najnižšej
úrovni protokol definuje správanie hardwarového spojenia.

Komunikácia v sieti prebieha na jednotlivých vrstvách (úrovniach). Každá vrstva vykonáva
špecifickú funkciu a komunikuje s vrstvou na rovnakej úrovni. Poskytuje svoje služby vrstve
vyššej a naopak využ́ıva služby vrstvy nižšej. Typickým pŕıkladom vrstevnej komunikácie
je model ISO/OSI. Tento model je snahou o štandardizáciu komunikácie v poč́ıtačových
siet’ach.

Medzi najznámeǰsie komunikačné protokoly patria napŕıklad protokoly HTTP, SMTP, IP,
TCP a d’al’̌sie.

2.1 Bezpečnostné protokoly

Samostatnú oblast’ komunikačných protokolov predstavujú bezpečnostné protokoly. Tie
nachádzajú uplatnenie najmä v situáciách, kde potrebujeme prenášat’ citlivé informácie ako
napŕıklad tajné kl’́uče, autentizačné údaje pŕıpadne transakcie na bankovom účte. Tieto pro-
tokoly zaist’ujú pomocou kryptografických mechanismov (šifrovania) základné bezpečnostné
funkcie ako sú autentizácia, autorizácia, integrita, dôvernost’ a niekedy nepopieratel’nost’.
Bezpečnostné funkcie možno uplatnit’ na každej z vrstiev referenčného ISO/OSI modelu [8].

Fyzická vrstva Problémy fyzickej vrstvy majú technický alebo technologický charakter.
Cielený útok na túto vrstvu, može byt’ napŕıklad: prerušenie vodičov, úmyselné rušenie
(interferencia, zkreslenie, . . . ), odposluch (bezdrôtové prenosy), zachytenie vyžarovania.
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Linková vrstva Protokoly linkovej vrstvy spravidla zaist’ujú ochranu proti technickým
zlyhaniam (kontrolné súčty, sekvenčné č́ısla rámcov, . . . ) a zaist’ujú ochranu proti úmy-
selným útokom. Takým protokolom je špecifikácia PPP (Point-to-Point Protocol), ktorá
pozostáva zo sady protokolov a tie zapúzdrujú rámce prenosových technológíı Ethernet,
ATM, FrameRelay, HDLC za účelom zabezpečenia autenticity a dôvernosti spojenia. Patria
sem napŕıklad protokoly LCP, PAP, CHAP, EAP [10].

Siet’ová vrstva Z hl’adiska informačnej bezpečnosti je táto vrstva vel’mi významná, pre-
tože môže byt’ na nej uplatnená rada bezpečnostných služieb. Poskytuje autentizáciu, dôve-
ryhodnost’ a integritu. Bezpečnostné protokoly siet’ovej vrstvy sú bud’ řiešenia proprietárne
(SKIP) alebo štandardy (IPsec) [10].

Transportná vrstva Bezpečný transport dát zaist’ujú protokoly SSL (Secure Socket La-
yer) a TLS (Transport Layer Security Protocol). Implementačná vrstva SSL/TLS je medzi-
vrstvou transportnej a aplikačnej vrstvy TCP/IP architektúry. Zaist’uje bezpečnost’ rôznym
aplikačným protokolom ako sú napŕıklad HTTP, FTP, IMAP. Bezpečnostné služby, ktoré
protokoly SSL/TLS pokrývajú sú dôvernost’, integrita, autentifikácia a nepopieratel’nost’
[10].

Aplikačná vrstva Najvyššia vrstva architektúry TCP/IP ponúka najviac možnost́ı pre
implementáciu bezpečnostných služieb v komunikačńıch procesoch. Niektoré z implemen-
tácíı môžu byt’ zdiel’ané rôznymi siet’ovými službami. Z tejto skupiny je vel’mi perspekt́ıvny
protokol SET (Secure Electronic Transaction), ktorý je určený pre internetové platobné
transakcie [10].

Z hl’adiska šifrovania komunikácie (správ), možno bezpečnostné protokoly rozdelit’ na pro-
tokoly použ́ıvajúce asymetrické a symetrické šifrovanie.

Asymetrické šifrovanie Pri tomto type šifrovania sú použité dva typy kl’́učov. Súkromný
a verejný. Súkromný kl’́uč je tajomstvom vlastńıka a umožňuje dešifrovanie správy. Verejný
kl’́uč šifruje správu a je vol’ne k dispoźıcii. Medzi algoritmy patŕı RSA, DSA, Diffie-Hellman.
Pŕıkladom využitia sú protokoly IKE, TMN alebo SET. Asymetrický model možno použit’
pre implementáciu dôvernosti, autentizácie a nepopieratel’nosti (digitálny podpis) [9].

Symetrické šifrovanie Použ́ıva jeden typ šifrovacieho kl’́uča – tajný kl’́uč (zdielaný kl’́uč).
Slúži zároveň na šifrovanie a dešifrovanie. Ktokol’vek, kto vlastńı tento kl’́uč má pŕıstup
k správe. Medzi algoritmy patŕı DES, 3DES, IDEA, RC2, RC5, AES. Pŕıkladom je Yahalom
protokol. Symetrické šifrovanie zaist’uje dôvernost’ a autentizáciu [9].

2.2 Funkcie bezpečnostných protokolov

Ako bolo spomenuté, medzi hlavné funkcie (služby), ktoré poskytujú bezpečnostné proto-
koly patria autentizácia, autorizácia, integrita, dôvernost’ a nepopieratel’nost’.
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2.2.1 Autentizácia

Autentizácia je proces, ktorý rieši overenie identity jendej alebo obidvoch komunikujúcich
strán. Pokial’ je v komunikačnom protokole zaradený kvalitný autentizačný mechanizmus,
je pre útočńıka vel’mi obtiažne podvrhnút’ zprávu s falošným pôvodom [15].

Silná autentizácia Systém umožňuje silnú autentizáciu ak je splnená nasledujúca pod-
mienka: pokial’ subjekt A obdrž́ı správu, v ktorej je ako odosielatel’ uvedený subjekt B,
potom B odoslal práve túto správu subjektu A [15].

Slabá autentizácia Systém umožňuje slabú autentizáciu ak je splnená nasledujúca pod-
mienka: pokial’ subjekt A obdrž́ı správu a ako odosielatel’ je uvedený subjekt B, potom bud’
B odoslal práve túto správu subjektu A alebo B uvedenú skutočnost’ poprie [15].

Identitu možno overit’ pomocou [16]:

• toho, čo použ́ıvatel’ pozná, napŕıklad meno, heslo alebo PIN

• toho, čo použ́ıvatel’ vlastńı, napŕıklad privátny kl’́uč, smart card

• toho, č́ım použ́ıvatel’ je, napŕıklad biometrické údaje

• toho, čo použ́ıvatel’ dokáže, napŕıklad CAPTCHA

2.2.2 Autorizácia

Autorizácia alebo tiež služba riadenia pŕıstupu, zaist’uje udelenie, pŕıpadne odoprenie pŕı-
stupu na základe overenia identity. Najčasteǰsie je spájaná práve so službou autentifikácie.
Autentifikačné údaje môžu byt’ d’alej porovnané napŕıklad s tabul’kou pŕıstupových práv
(ACL) a výsledkom je úroveň oprávnenia pristupovat’ k požadovanej informácíı či objektu.
Tieto služby bývajú málokedy súčast’ou siet’ových protokolov a často sú implementované až
v operačnom systéme alebo aplikácíı [8].

2.2.3 Integrita

Integrita je vlastnost’, kedy prenášané dáta nesmú byt’ zmenené žiadnou neautorizovanou
stranou, nesmú byt’ umelo zadržiavané, či opakovane vysielané po neoprávnenom odpo-
sluchu [15]. Úlohou tejto služby je teda najčasteǰsie pomocou kryptografických algoritmov
zabezpečit’ túto vlastnost’. Z kryptografických algoritmov sa použ́ıvajú napŕıklad MD5,
SHA-1, SHA-2.

Službu možno rozdelit’ na [8]:

• Integrita spojenia – poskytuje ochranu pred neautorizovanou modifikáciou bez ohl’adu
na nadviazané spojenia.

• Integrita prenosu zpráv – zaist’uje ochranu pred neautorizovanou modifikáciou v rámci
nadviazaného spojenia.

• Selekt́ıvna integrita spojenia a selekt́ıvna integrita zpráv – majú za úlohu zaistit’
integritu iba niektorých čast́ı prenášanej správy.
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2.2.4 Dôvernost’

Táto skupina služieb poskytuje ochranu prenášaných dát pred neautorizovaným odhaleńım.
Službu možno rozdelit’ na [8]:

• Dôvernost’ prenosu správ – poskytuje ochranu pred neautorizovaným odhaleńım bez
ohl’adu na nadviazené spojenie.

• Dôvernost’ spojenia – zaist’uje ochranu pred neautorizovaným odhaleńım v rámci
nadviazaného spojenia. Táto služba vyžaduje existujúce spojenie.

• Dôvernost’ toku dát (Traffic Flow Confidentiality) – má za úlohu zabránit’ útočńıkovi,
aby zo znalost́ı toku dát (adresy prenášaných správ, d́lžka prenášaných správ, časové
intervaly medzi prenášanými správami, . . . ) dokázal odvodit’ dôverné informácie o pre-
nášaných dátach.

• Selekt́ıvna dôvernost’ – má za úlohu zaistit’ dôvernost’ iba niektorých čast́ı prenášanej
správy.

2.2.5 Nepopieratel’nost’

Služba nepopieratel’nost’ (odosielatel’a, doručenia), má za úlohu jednoznačne preukázat’
pŕıjemcovi resp. odosielatel’ovi na jednej strane, odoslanie resp. prijatie na strane druhej.

2.3 Popis protokolov

2.3.1 Formálny popis

Správa Je základným prvkom komunikácie. Správy, ktoré sú vymieňané medzi subjek-
tami pomocou protokolu, sú zložené z menš́ıch, atomických správ. Existujú štyri typy ato-
mických správ [4]:

• Kl’́uče – sú pož́ıvané k šifrovaniu správ. Hlavnou vlastnost’ou je, že každý kl’́uč k má
kl’́uč inverzný k−1. Pri symetrickom šifrovańı, je dešifrovaćı kl’uč rovnaký ako šifrovaćı,
teda k = k−1. Zároveň plat́ı (k−1)−1 = k.
Kl’́uče sa označujú: Ka,Kb,Kab, . . .

• Nonce – si možno predstavit’ ako náhodne generované č́ısla. Základom je, aby nikto
nebol schopný vopred odhadnút’ túto hodnotu. Zaručuje tzv. čerstvost’ správy (fresh-
ness). Každá správa obsahujúca nonce je generovaná po tom, čo bola vygenerovananá
hodnota nonce. Nonce sa označuje: Na, Nb, . . .

• Dáta – neovplyvňujú spôsob fungovania protokolu ale sú predmetom komunikácie.

• Mená účastńıkov – odkazujú na účastńıkov komunikácie. Účastńıci sa najčasteǰsie
označujú ako: A,B, S, . . . (Alice, Bob, Server, . . . )

Správy zložené z atomických správ sa označujú ako zložené správy a zapisujú sa {M,N}.
Zašifrovaná správa M , kl’́učom k sa zapisuje {M}k. Odoslanie správy možno zaṕısat’:

A→ B : {A,Na}k
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2.3.2 Jazyky

SPL (Security Protocol Language) je asynchrónny, procesne orientovaný jazyk založený
na π-Calculus. Každý agent (proces) je definovaný ako výraz (term) v algebre. Tá umožňuje
prezentovat’ sekvenčné aj paralelné vstupné a výstupné akcie [3]. Akcie môžu obsahovat’
správy.

Napŕıklad odoslanie správy od A k B, ktorá bude obsahovat nonce, sa zaṕı̌se

out new{y}{y,A}Pub(B)

kde y predstavuje nonce. Prijatie očakávanej správy sa zaṕı̌se

in pat{x, Z}{x, Z}Pub(B)

kde Z je vzor očakávanej správy (pattern).

NetPDL (Network Protocol Description Language) je aplikačne nezávislý jazyk pre po-
pis paketov, ktorý umožňuje vytvárat’ univerzálnu databázu s popismi protokolov. Jednou
z hlavných výhod je jednoduchost’ popisu. NetPDL sa nezameriava na popis správania pro-
tokolu. Naproti tomu sa zameriava na efekt́ıvny popis paketov, ich hlavičiek a zapúzdrenia.
NetPDL je založený na XML a preto je možné ho spracovat’ pomocou programov a knižńıc
podporujúcich XML. Zároveň je možné jednoducho aktualizovat’ zmeny v špecifikácíı pro-
tokolov [20].

Pŕıklad hlavičky paketu IPv4 zaṕısaného v NetPDL:

<protocol name=’IPv4’>
<format>

<fields>
<field type=’bit’ name=’ver’ longname=’Version’ size=’1’
mask=’0xF0’/>
<field type=’bit’ name=’hlen’ longname=’Header length’ size=’1’
mask=’0x0F’/>
<field type=’fixed’ name=’tos’ longname=’Type of service’ size=’1’/>
...

</fields>
</format>

</protocol>

HLPSL Jazyk je vyv́ıjaný v rámci frameworku projektu AVISPA. Je modulárny a u-
možňuje špecifikáciu riadiaceho toku, datových štruktúr a rôznych modelov útokov. Jeho
sémantika je postavená na Lamport’s TLA (Temporal Logic of Actions). Definuje popis
roĺı pomocou konečného automatu, kde prechod znamená prijatú alebo odoslanú správu.
Explicitne definuje role, generovanie nonce a výmenu správ [2].

Pŕıklad zápisu role v jazyku HLPSL:

role alice(A,B:agent, G:text, Snd,Rcv:channel(dy)) played_by A def=
local State:nat, Na,Nsecret:text, X,K:message
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init State:=1
transition
1. State=1 /\ Rcv(start) =|>

State’:=2 /\ Na’:=new() /\ Snd(exp(G,Na’))
2. State=2 /\ Rcv(X’) =|>

State’:=3 /\ K’:=exp(X’,Na) /\ Nsecret’:= new() /\ Snd({Nsecret’}_K’)
end role

Role sú spojené v session, kde zdiel’ajú vedomosti:

role session (A,B:agent, G:text) def=
local SND_A,RCV_A,SND_B,RCV_B:channel(dy) def=

composition
alice(A,B,G,SND_A,RCV_A) /\ bob(B,A,G,SND_B,RCV_B)

end role

Prostredie slúži k spusteniu a verifikácíı protokolu. Nastavuje úvodné vedomosti útočńıka
a session:

role environment() def=
const a,b:agent, g:text

composition
session(a,b,g,Snd,Rcv)

end role

CAS+ Jazyk bol navrhnutý pre jednoduchú špecifikáciu a verifikáciu bezpečnostných
protokolov. Hlavným ciel’om bolo vytvorit’ jazyk, ktorý by bol jednoduchý a poskytoval
možnosti jazyka HSPSL [21]. Špecifikácia protokolu pozostáva zo šiestich čast́ı: deklarácia
identifikátorov, postupnost’ správ, znalosti agenta, session premenné, znalosti útočńıka
a ciel’ verifikácie.

Pŕıklad zápisu protokolu:

protocol TV; % symmetric key
identifiers
A,B : user;
Ins : number;
K : symmetric_key;

messages
1. B -> A : B,{Ins}K
2. A -> B : A,B,{Ins}K

knowledge
B : A,K;
A : K;

session_instances
[B:tv,A:scard,K:onekey];

intruder_knowledge
scard;

goal
A authenticates B on Ins;

9



2.4 Formálna verifikácia

Formálna verifikácia je proces overenia, či daný model (algoritmus) sṕlňa špecifikáciu.

Kontrola modelom Je založená na konštrukcii pravdepodobnostných množ́ın útokov,
ktoré vychádzajú z algebraických vlastnost́ı protokolov [15]. Môže dôjst’ k expanzii stavov,
pretože je potrebné prehl’adat’ stavový priestor. Pŕıkladom sú rôzne špecifikačné jazyky
a expertné systémy.

Autentizačná logika Predstavuje modálnu logiku podobnú tým, ktoré boli vytvorené
pre analýzu a vývoj vedomost́ı a predpokladov. Je založená na axiomizácíı vedomost́ı a pred-
pokladov [15]. Pŕıkladom je BAN, GNY pŕıpadne KPL logika.

Indukt́ıvne techniky Tieto metódy nahrádzajú náročné prehl’adávanie teorémov o tomto
prehl’adávańı. Tieto techniky sú komplementom ku kontrole modelom. Sú založené na for-
malizácíı problémov, pri ktorých sa použ́ıvajú hypotézy a autentizačné vlastnosti. Techniky
formálne modelujú aktuálne operácie v protokole a overujú teorémy týchto operácíı [15].
Pŕıkladom je theorem proving (Isabelle) alebo spi calculus.

2.5 Metódy útokov

K základným typom útokov, ktoré majú za ciel’ odhalit’ obsah prenášaných informácíı
alebo prerušit’ komunikáciu patŕı odpočúvanie, podstrčenie falošnej identity, modifikácia
prenášaných správ a prerušenie komunikácie.

Odpočúvanie Komunikácia medzi dvoma subjektami Alice a Bob je odpočúvaná útočńı-
kom. Útočńık vystupuje ako paśıvny účastńık.

Prerušenie komunikácie Komunikácia medzi subjektom Alice a Bob je prerušená úto-
čńıkom.

Podstrčenie identity Útočńık predstiera falošnú identitu voči niektorému zo subjektov
komunikácie.

Modifikácia správy Útočńık modifikuje správy posielané medzi dvoma subjektami.

2.5.1 Útok zo stredu

Tento útok spoč́ıva v tom, že útočńık vstúpi do komunikácie medzi subjekty Alice a Bob.
Útočńık odpočúva, analyzuje a pŕıpadne pozmeňuje správy. Zároveň útočńık predstiera voči
Alice identitu Boba a voči Bobovi predstiera identitu Alice. Obe strany komunikujú bežným
spôsobom a nevedia o pŕıtomnosti útočńıka. Útok je znázornený na obr. 2.2. Prevenciou je
použitie silnej autentifikácie, PKI (public key infrastructure) a súkromných kl’́učov. Jedná
sa o akt́ıvny typ útoku [14, 12].
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Alice BobÚtočník

M1
M1

(a) Odpočúvanie

Alice BobÚtočník

M1

(b) Prerušenie komunikácie

Alice BobÚtočník

M1

(c) Podstrčenie identity

Alice BobÚtočník

M1
m'1

(d) Modifikácia správy

Obrázek 2.1: Metódy útokov v sieti (časový diagram)

Alice BobÚtočník

M1
m'1

M2
m'2

Obrázek 2.2: Útok zo stredu (časový diagram)

2.5.2 Útok prehrávańım

V tomto útoku, podobne ako pri útoku zo stredu, vystupuje útočńık v roli prostredńıka.
Útočńık odpočúva komunikáciu a následne ju opakuje voči niektorému zo subjektov, pričom
tento daný subjekt nedokáže overit’ jeho skutočnú identitu. Ochranou voči tomuto typu
útoku je použitie časového raźıtka [15]. Podobne ako útok zo stredu aj tento útok je akt́ıvny.
Útok je znázornený na obr. 2.3.

Alice BobÚtočník

M1
M1

M2

M1

M2
M2

Obrázek 2.3: Útok prehrávańım (časový diagram)
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Kapitola 3

Nástroje

V nasledujúcej kapitole predstavujem nástroje umožňujúce návrh, analýzu a simuláciu bez-
pečnostných protokolov. Ku každému nástroju uvádzam detailný popis vrátane zdroja, typu
licencie a podporovaných operačných systémov.

3.1 AVISPA

Adresa: http://avispa-project.org/

Aktuálna verzia: 1.1

Autor: Alessandro Armando, Yannick Chevalier, David Basin, Jorge Cuellar, . . .

Licencia: Neuvedená

Podporované OS: Linux, Mac OS (Software) / všetky OS (Webové rozhranie)

AVISPA je projekt založený európskou komisiou ako súčast’ programu Information Society
Technologies Programme a vznikol 1.1.2003. V rámci projektu AVISPA vznikol rovnomenný
nástroj na tvorbu a analýzu bezpečnostných protokolov [18].

Vstup v jazyku HLPSL
Prekladač

HLPSL2IF

Intermediate Format (IF)

Kontrola modelu

on-the-fly

OFMC

Hľadanie útokov 

založené na CL

CL−AtSe

Kontrola modelu 

pomocu SAT

SATMC

Analýza protokolu 

pomocou automatu

TA4SP

Výstup

Obrázek 3.1: AVISPA architektúra

Nástroj sa skladá z niekol’kých komponent. Jeho architektúra je znázornená na obr.3.1. Na
vstupe očakáva popis protokolu v jazyku HLPSL (vrátane vlastnost́ı, ktoré chceme verifiko-
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vat’). Tento vstup následne prevedie pomocou prekladača HLPSL2IF Translator do ekviva-
lentnej špecifikácie vo formálnom jazyku IF (Intermediate Format). Takto transformovanú
špecifikáciu odovzdá na vstup jednotlivým komponentám. Každá komponenta implemen-
tuje rôzne techniky, ktoré prehl’adavajú odpovedajúci stavový priestor a hl’adajú stavy, ktoré
predstavujú útoky na špecifikované vlasnosti (model checking). Výstupný formát kompo-
nent je presne definovaný a udáva či bol problém nájdený, pŕıpadne či nastala chyba [24].

Nástroj existuje v dvoch verziách. Software stiahnutel’ný z domovskej stránky určený pre
Linux a Mac OS alebo ako webové rozhranie nachádzajúce sa na domovskej adrese.

Obrázek 3.2: Needham–Schroeder Public Key protokol v programe AVISPA

Výhody:

• Rôzne komponenty určené k analýze protokolu

• Multiplatformný nástroj (webové rozhranie)

• Vizualizácia útoku na protokol

Nevýhody:

• Nie je možné vizualizovat’ priebeh protokolu

3.2 GRASP

Adresa: Nezistená

Aktuálna verzia: Nezistená

Autor: Air Force Academy (VISE)

Licencia: Nezistená
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Podporované OS: Windows, Linux, Mac OS (Java)

GRASP (GRaphical Aid for Security Protocols) je nástroj určený k interakt́ıvnej vizu-
alizácíı bezpečnostných protokolov. Ciel’om pri návrhu nástroja bolo graficky ilustrovat’
bezpečnostné protokoly a umožnit’ interakt́ıvne menit’ parametre (on-the-fly) s ciel’om po-
zorovat’ zmeny. Zároveň musel byt’ dostatočne jednoduchý a názorný. Primárne mal byt’
nasadzovaný ako učebná pomôcka [23].

GRASP je naṕısaný v jazyku Java (Swing) čo z neho rob́ı multi-platformný nástroj. Po-
zostáva z troch hlavných čast́ı: editačné okno (zadávanie vstupu), oblast’ okna s výsledkami,
kde sa zobrazujú účastńıci a ich znalosti a časový diagram znázorňujúci interaktivitu medzi
účastńıkmi (posielanie správ). Má vlastný jazyk pre popis protokolov s vel’mi jednoduchou
syntaxou. V každom kroku simulácie má použ́ıvatel’ možnost’ menit’ parametre prostredia,
počet účastńıkov, správy a pozorovat’ zmeny.

Program je vyv́ıjaný v rámci Air Force Academy (VISE) a je vol’ne dostupný [23].

Obrázek 3.3: Diffie–Hellman protokol v programe GRASP [23]

Výhody:

• Interakt́ıvny nástroj s podporou on-the-fly zásahov do simulácie

• Multi-platformný nástroj programovaný v Jave

Nevýhody:

• Nedostupnost’ nástroja na internete (v čase ṕısania práce nebol dostupný)

3.3 Scyther

Adresa: http://people.inf.ethz.ch/cremersc/scyther/index.html
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Aktuálna verzia: 1.0-beta7

Autor: Cas Cremers

Licencia: Nešpecifikovaná (Vol’ne stiahnutel’né)

Podporované OS: Windows, Linux, Mac OS

Scyther je vol’ne stiahnutel’ný nástroj, určený predovšetkým na verifikáciu a analýzu bezpe-
čnostných protokolov. Je postavený na algoritme, ktorý poskytuje zhustenú reprezentáciu
(nekonečnej) množiny stôp. To pomáha nástroju pri analýze tried možných útokov a chova-
nia protokolu. Nástroj umožńı dokazovat’ správnost’ bližšie nešpecifikovaného počtu spojeńı.
Dokáže pracovat’ paralelne s niekol’kými (pod)protokolmi [6].

Program je naṕısaný v jazyku Python a má konzolové ovládanie ako aj grafické rozhranie.
Ako vstup očakáva popis protokolu v jazyku SPDL. Program dokáže zistit’, či sú dodržané
bezpečnostné požiadavky v protokole pŕıpadne tieto bezpečnostné požiadavky generovat’
a následne overit’. Dokáže analyzovat’ protokol na základe interakcie účastńıkov.

Program nedokáže pracovat’ interakt́ıvne a nedokáže za behu menit’ podmienky. Je nutné
upravit’ zdrojový súbor (napr. vo vstavanom editore) a následne spustit’ analýzu. Vzhl’adom
na jeho rýchlost’, názornost’ a jednoduchost’ sa hod́ı ako učebná pomôcka.

Obrázek 3.4: Needham–Schroeder protokol v programe Scyther

Výhody:

• Rýchlost’ kompilácie

• Podpora vel’kého počtu komunikačných spojeńı (neobmedzený počet [6])
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• Pracuje paralelne s niekol’kými (pod)protokolmi

• Jednoduchost’ použitia a názornost’ pri zobrazeńı činnosti protokolu

Nevýhody:

• Nutnost’ kompilácie vstupu pred samotnou analýzou

• Nemožnost’ menit’ parametre protokolu za behu

3.4 SPAN

Adresa: http://www.irisa.fr/celtique/genet/span/

Aktuálna verzia: 1.6

Autor: Yann Glouche, Thomas Genet, Olivier Heen, Erwan Houssay, Ronan Saillard

Licencia: LGPL

Podporované OS: Windows, Linux, Mac OS

SPAN nástroj je vol’ne dostupný pod licenciou LGPL. Je postavený na verifikačnom nástroji
AVISPA a pridáva hlavne podporu animácie [7]. Na vstupe očakáva protokol poṕısaný v ja-
zyku HLPSL alebo CAS+. Zo vstupu v jazyku CAS+ si automaticky vytvoŕı odpovdajúci
HLPSL vstup. Tento vstup d’alej spracuje a výsledkom je postupnost správ posielaných
v protokole.

Nástroj následne dokáže prehl’adne zobrazovat’ správy v podobe sekvenčného diagramu.
Dokáže krokovat’ priebeh komunikácie. Použ́ıvatel’ si može nastavit’ sledované premenné
(napr. nonce, A, B, . . . ) a tie počas animácie sledovat’. Podporuje vetvenie komunikácie
a v každom kroku ponúkne d’al’̌sie možnosti, ktorým sa komunikácia bude uberat’. Výslednú
postupnost’ správ (interný formát programu) možno uložit’ vo formáte postscript alebo PDF
a v budúcnosti kedykol’vek nač́ıtat’.

Program dokáže pracovat’ interakt́ıvne a krokovat’ priebeh simulácie. Je vhodný ako učebná
pomôcka.

Výhody:

• Ineraktivita počas simulácie

• Rýchla kompilácia

• Názornost’ zobrazenia protokolu

Nevýhody:

• Nutnost’ kompilovat’ vstup do interného formátu programu

• Mierne neprehladné GUI
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Obrázek 3.5: Needham–Schroeder Shared Key protokol v programe SPAN

3.5 SPEAR 2

Adresa: http://www.cs.uct.ac.za/Research/DNA/SPEAR2/index.html

Aktuálna verzia: 1.0.0.25

Autor: Elton Saul

Licencia: Neuvedená (Vol’ne stiahnutel’né)

Podporované OS: Windows

SPEAR 2 je nástroj na návrh a analýzu bezpečnostných protokolov. Vychádza z pôvo-
dného SPEAR projektu a hlavným ciel’om je poskytnút’ univerzálny framework, ktorý
by umožnil efekt́ıvne navrhovat’ bezpečnostné protokoly. Kombinuje formálnu špecifikáciu,
analýzu výkonnosti a bezpečnosti a automatické generovanie kódu. Využ́ıva upravenú ver-
ziu GNY logiky (autentizačná logika) doplnenú o digitálne podpisy a certifikáty [22].

Nástroj poskytuje prehl’adné použ́ıvatel’ské rozhranie pre pohodlné vytvorenie nového alebo
existujúceho protokolu. Podporuje ASN.1 zápis (popis správ). Podporuje nač́ıtanie a uk-
ladanie do interného formátu (špecifický pre SPEAR2). Umožňuje export protokolu do
formátu LATEX, PROLOG alebo do textového súboru. Pre grafickú prezentáciu využ́ıva
sekvenčný diagram. Program neumožňuje interakt́ıvnu simuláciu. Je vhodný predovšetkým
pre fázu návrhu a verifikácie bezpečnostných protokolov.

Výhody:

• Kvalitné GUI a jednoduché vytváranie protokolov

Nevýhody:

• Nepodporuje žiadny z dostupných jazykov pre popis protokolov
• Neposkytuje možnosti vizualizácie útokov
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Obrázek 3.6: Needham–Schroeder protokol v programe SPEAR 2

3.6 NS2

Adresa: http://www.isi.edu/nsnam/ns/

Aktuálna verzia: 2.34

Autor: M.Sc. Frida Eng, Ph.D. Fredrik Gunnarso

Licencia: GNU GPL

Podporované OS: Windows (Cygwin), UNIX, Linux, Mac OS

Vývoj NS2 vychádza z projektu REAL network simulator. Je určený na simuláciu smero-
vaćıch a multicastových protokolov. Rovnako podporuje simuláciu známych protokolov ako
sú TCP, UDP, RTP, SRM. Program je naṕısaný v jazyku C++, Tcl, OTcl (Object Tcl).
Je vol’ne š́ıritel’ný pod licenciou GNU GPL, objektovo-orientovaný a poskytuje prostriedky
pre špecifikáciu vstupných dát aj pre analýzu a prezentáciu výsledkov [18].
Program očakáva vstup v jazyku Tcl. V skripte je nutné poṕısat’ siet’ovú topológiu a komu-
nikačný protokol (posielanie a prij́ımanie správ).

Program je modulárny a podporuje tvorbu (programovanie) nových modulov. Pri inštalácii
je potrebné kompilovat’ zdrojové kódy a vyžaduje množstvo závislost́ı. Jeho použ́ıvatel’ské
rozhranie (založené na OTcl) je zastaralé, obsahuje však všetky potrebné nástroje pre tvorbu
simulovaného prostredia. Simulácia umožňuje krokovanie a rozhranie obsahuje prehl’adnú
časovú os.

Výhody:

• Vol’ne dosupný pod licenciou GNU GPL a možnost’ prispiet’ k vývoju prostredńıctvom
modulov
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Obrázek 3.7: Simulácia siet’ovej komunikácie v NS2

• Podporuje široké možnosti tvorby simulovaného prostredia

Nevýhody:

• Zastaralé GUI

• Neobsahuje nástroje pre verifikáciu bezpečnostných nástrojov ako ostatné uve-
dené nástroje.
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Kapitola 4

Implementácia bezpečnostných
protokolov

V tejto kapitole odsimulujem vhodne zvolené bezpečnostné protokoly pomocou nástrojov
uvedených v kapitole predchádzajúcej. Ciel’om bude demonštrovat’ spôsoby implementácie.

Ako pŕıklad som vybral protokoly Needham-Schroeder Public Key a Yahalom. Hlavným
kritériom pri výbere bola zložitost’ protokolu, tj. je vhodné aby zložitost’ ich návrhu pokryla
možnosti nástrojov. V protokole by mali vystupovat’ viaceŕı účastńıci. Rovnako je vhodné
aby posielané správy obsahovali identity subjektov, hodnoty nonce a kl’́uče (symetrické,
verejné, súkromné). Ďal’̌śım významným kritériom je existencia zranitel’nost́ı. Jednotlivé
nástroje by mali byt’ schopné odhalit’ a znázornit’ potenciálny útok.

V druhej časti kapitoly porovnám nástroje z pohl’adu implementácie vrátane možnost́ı,
ktoré ponúkajú pri zadávańı vstupu.

4.1 Needham-Schroeder Public Key protokol

Jedná sa o verziu Needham-Schroeder protokolu založenú na asymetrickom šifrovańı. Posky-
tuje vzájomnú autentifikáciu subjektov použit́ım dôveryhodného kl’́uča serveru a verejných
kl’́učov. Server distribuuje kl’́uče na požiadanie. Protokol bol navrhutý ku komunikácíı cez
nezabezpečenú siet’ [13]. Autormi je dvojica Roger Needham a Michael Schroeder.

Formálny popis protokolu

1. A→ S : A,B
2. S → A : {Kpb, B}Kss

3. A→ B : {Na, A}Kpb

4. B → S : B,A
5. S → B : {Kpa, A}Kss

6. B → A : {Na, Nb}Kpa

7. A→ B : {Nb}Kpb

(4.1)
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Obrázek 4.1: Needham-Schroeder Public Key protokol

Známy útok Protokol je náchylný na útok typu man-in-the-middle. Útočńık I sa môže
vydávat’ za účastńıka A tak, že ho donúti iniciovat’ s ńım nové spojenie. Správy preposiela
smerom k B (predstiera identitu A). V dôkaze (4.2) sa predpokladá komunikácia len medzi
A,B, I. Rovnako sa predpokladá znalost’ kl’́učov (Ka,Kb,Ki) u jednotlivých účastńıkov
[13, 11].

1.3. A→ I : {Na, A}Kpi

2.3. I(A)→ B : {Na, A}Kpb

2.6. B → I(A) : {Na, Nb}Kpa

1.6. I → A : {Na, Nb}Kpa

1.7. A→ I : {Nb}Kpi

2.7. I(A)→ B : {Nb}Kpb

(4.2)

Modifikácia Lowe túto chybu odstraňuje pridańım identity B do správy [11]:

2.6 B → A : {Na, Nb, B}Ka

(4.3)

4.2 Yahalom protokol

Poskytuje vzájomnú autentifikáciu účastńıkov a distribúciu tajného kl’́uča. Bol navrhnutý
pre použitie cez nezabezpečenú siet’ (napr. Internet). Využ́ıva symetrické šifrovanie. O dis-
tribúciu tajného kl’́uča sa stará dôveryhodný arbiter (server) [17].
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Obrázek 4.2: Yahalom protokol

Formálny popis protokolu

1. A→ B : A,Na

2. B → S : B, {A,Na, Nb}Kbs

3. S → A : {B,Kab, Na, Nb}Kas , {A,Kab}Kbs

4. A→ B : {A,Kab}Kbs
, {Nb}Kab

(4.4)

Známy útok K Yahalom protokolu nebol publikovaný žiadny útok [17].

4.3 Spôsob implementácie

Z kapitoly 3 sú dostupné a zároveň využitel’né pre simuláciu bezpečnostných protokolov
nástroje AVISPA, SPAN, Scyther, SPEAR 2. Každý z nich sa vyznačuje vlastným imple-
mentačným jazykom. Prehl’ad podporovaných jazykov je v tabul’ke 4.1.

AVISPA SPAN Scyther SPEAR 2

Jazyk HLPSL HLPSL, CAS+ SPDL SPR

Tabulka 4.1: Prehl’ad jazykov podporovaných v nástrojoch

Rozhodol som sa preto ku každému nástroju pristupovat’ jednotlivo a ako základ implemen-
tovat’ zvolené protokoly.

4.3.1 Implementácia v AVISPA

Nástroj podporuje implementáciu jedine v jazyku HLPSL. Jazyk berie ako základ popis roĺı.
Každá z roĺı popisuje aké informácie účastńık pozná na začiatku, začiatočný stav a prechody
(zmena stavu) [1]. V podstate sa jedná o prepis stavového automatu do textovej podoby.
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Prijatie alebo odoslanie správy vyvolá prechod do iného stavu. Reláciu prechodu zaṕı̌seme
ako =|> a zjednotenie ako /\.

Začneme s deklaráciou samotnej role, ktorá má tvar

role alice (A, B: agent,
Ka, Ks: public_key,
KeyRing: (agent.public_key) set, % Množina kl’́učov
Snd, Rcv: channel(dy)) % Komunikačný kanál

kde parameter dy znamená model útočńıka. Pokračujeme jej správańım a lokálnymi pre-
mennými. Premenné musia zač́ınat’ vel’kým ṕısmenom a konštanty malým.

played_by A def=
local State : nat, % Prirodzené čı́slo

Na, Nb: text, % nonce
Kb: public_key

init State := 0 % Počiatočný stav
transition
...

end role

Prechod teda znamená sériu počiatočných podmienok a akcíı spustených po jeho vykonańı.
Prechody možeme rozĺı̌sit’ identifikátorom (v nasladujúcom pŕıklade ask.)

ask. State = 0 /\ Rcv(start) /\ not(in(B.Kb’, KeyRing))
=|> State’:= 1 /\ Snd(A.B)

Takto definovanú rolu spoj́ıme spolu s ostatnými do kompoźıcie (session) protokolu a d’alej
do kompoźıcie prostredia. Prostredie definuje aj rolu útočńıka.

composition
/\_{in(A.B.Ka.Kb,Instances)} (alice(A,B,Ka,Ks,KeySet(A),Snd,Rcv)
/\ bob(A,B,Kb,Ks,KeySet(B),Snd,Rcv))

Na záver definujeme množinu ciel’ových bezpečnostných požiadavkov (tajnost’, autenti-
fikácia, . . . ) goal a najvyššiu kompoźıciu environment().

Komentáre až do konca riadku zač́ınajú %.

4.3.2 Implementácia v SPAN

U predchádzajúceho nástroja som poṕısal implementáciu v HLPSL, preto sa teraz budem
zaoberat’ jazykom CAS+. Oproti HLPSL sa vyznačuje jednoduchost’ou zápisu. Zdrojový
kód popisujúci protokol je prehl’adný a skladá sa z niekol’kých čast́ı. V úvode deklarujeme
názov protokolu (prvý riadok).

protocol NeedhamSchroederPublicKey;
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Nasleduje deklarácia identifikátorov a premenných (jednotlivé entity a kl’́uče). Deklaro-
vat’ možno public key (verejný kl’́uč), symetric key (symetrický kl’́uč), user (účastńık),
function (jednocestná funkcia napr. hash) a number (obecné dáta, nonce, záznam, text).

identifiers
A,B,S : user;
Na,Nb : number;
KPa,KPb,KPs : public_key;

V d’aľsej časti zaṕı̌seme postupnost’ správ. Táto čast’ tvoŕı jadro popisovaného protokolu.
Základný tvar je

(i. Si →i Ri : Mi)1≤i≤n

kde i ≤ n je č́ıslo kroku [21]. Privátny kl’́uč konč́ı apostrofom napr. Kab’. Zápis je podobný
formálnemu zápisu protokolov.

messages
1. A -> S : A,B
2. S -> A : {KPb, B}KPs’
3. A -> B : {Na, A}KPb
4. B -> S : B,A
5. S -> B : {KPa, A}KPs’
6. B -> A : {Na, Nb}KPa
7. A -> B : {Nb}KPb

Svoj význam má aj š́ıpka znázorňujúca zaslanie správy. Bežný kanál (Dolev-Yao) zaṕı̌seme
ascii znakom ->, kanál chránený proti zápisu a č́ıtaniu => a kanál chránený proti zápisu ∼>
[21].

Čast’ popisujúca znalosti účastńıkov, tj. všetky dáta, ktoré sú z pohl’adu účastńıkov známe
ešte pre začiatkom priebehu protokolu.

knowledge
A : A,B,S,KPa,KPb,KPs;
B : A,B,S,KPa,KPb,KPs;
S : A,B,S,KPa,KPb,KPs;

V časti session instances sa prirad’uje hodnota k premenným. V praxi to znamená, že
je možné poṕısat’ rôzne systémy v ktorých bež́ı protokol. Rovnako je možné v tejto časti
vytvorit’ session s útočńıkom I. K útočńıkovi sa vzt’ahuje aj deklarácia znalost́ı podobne
ako pri účastńıkoch.

session_instances
[A:alice,B:bob,S:server,KPa:pk1,KPb:pk2,KPs:pk3];

V poslednej časti uvedieme ciele (vlastnosti), ktoré chceme dokázat’. Existujú tri typy:
utajenost’, autentifikácia a slabá autentifikácia.

goal
A authenticates B on Na;
B authenticates A on Nb;

Komentáre do konca riadku zač́ınajú %.
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4.3.3 Implementácia v Scyther

Nástroj využ́ıva vlastný jazyk SPDL (Security Protocol Descritpion Language). Na pŕıpone
súboru nezalež́ı. Súbory môžeme do seba zanorovat’, čo sa hod́ı pri modelovańı zložiteǰśıch
protokolov

include ’filename’;

Scyther je postavený na manipulácii s výrazmi (term). Atomický výraz je pritom l’ubovolný
identifikátor, typicky ret’azec alfanumerických znakov [5]. K dispoźıcii sú základné predde-
finované typy Function (kl’́uče, hash), Agent (účastńıci), Nonce alebo Ticket a udalosti
Secret (tajomstvo).

Na úvod teda deklarujeme kl’́uče

const pk: Function;
secret sk: Function;
inversekeys(pk,sk); // Asymetrický pár kl’́učov

kde Const znač́ı globálnu konštantu. Nasleduje popis správania protokolu, ktorý má (v pŕı-
pade Needham Schroeder-PK) troch účastńıkov

protocol NeedhamSchroederPK(I,R,S) {}

V rámci protokolu definujeme správanie jednotlivých účastńıkov. Hodnoty, ktoré účastńık
pozná, zapisujeme na úvod. Komunikácia prebieha typicky posielańım a prij́ımańım správ.
Správy sú č́ıslované aby ich interpret dokázal správne zoradit’ do sekvenčného diagramu.
Najdôležiteǰsiu čast’ predstavujú bezpečnostné požiadavky (určujú kontrolované vlastnosti).

role I {
const Ni: Nonce; // Globálna premenná
var Nr: Nonce; // Lokálna premenná

send_1(I,S,(I,R)); // Správa od I k S, obsahujúca (I,R)
read_2(S,I, {pk(R), R}sk(S));
...
claim_I1(I,Secret,Ni);
claim_I2(I,Secret,Nr);
claim_I3(I,Nisynch);

}

V záverečných nastaveniach protokolu uvedieme dôveryhodných účastńıkov, nedôveryho-
dných útočńıkov (ciel’ útočńıka) a ohrozené dáta.

const Alice,Bob,Server,Compromised: Agent;
untrusted Compromised;
const nc: Nonce;
compromised sk(Compromised);

Jazyk je case-sensitive. Komentáre možno zapisovat’ viacerými spôsobmi podobne ako v ja-
zyku C. Jednoriadkový komentár # alebo //, pŕıpadne viacriadkový komentár /* */. Biele
znaky (nový riadok, medzera) sú ignorované.
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4.3.4 Implementácia v SPEAR 2

Nástroj sa od ostatných odlǐsuje hlavne možnost’ou modelovat’ protokoly priamo pomocou
použ́ıvatel’ského rozhrania. Táto vlastnost’ urýchl’uje a zjednodušuje celý proces. Samotný
vstupný súbor obsahujúci popisovaný protokol má niekol’ko desiatok kilobajtov, preto sa
zameriam hlavne na implementáciu pomocou GUI. Ako pŕıklad uvediem časti kódu zdro-
jového súboru.

Na úvod modelujeme účastńıkov (Design → AddCanvasObject → Principal). Na úrovni
zdrojového kódu majú účastńıci tvar

PRINCIPAL {
NAME = ’A’

}

Prejdeme k modelovaniu vlastných správ (Design → AddCanvasObject → Message).
V tomto kroku už máme k dispoźıcii objekty (účastńıkov) a teda pri vytvárańı obsahu
správy vyberáme z ponuky existujúcich objektov (Add → Existing → Component →
A). Ak naraźıme na neexistujúci objekt je nutné si ho najprv vytvorit’ (napr. symet-
rické/asymetrické kl’́uče). Situácia je rovnaká na úrovni zdrojového kódu. Objekty správy
vytvoŕıme ako

PAYLOAD (mcComponent, 15042384) {
ID = ’A’
ASN.1 = ’’

}

kde prvý parameter je typ objektu (napr. mcComponent, mcTimeStamp, mcPrivKey, mcPubKey,
mcSharedSecret, mcPrivEncryption) a druhý parameter je identifikátor, na ktorý sa
neskôr budeme odkazovat’. Ako je možné vidiet’ program podporuje ASN.1 zápis.

Postupne môžeme prejst’ k modelovaniu vlastných správ. Zápis správy obsahuje identifikáciu
odosielatel’a, pŕıjemcu, akciu pred/po odoslańı/prijat́ı a identifikátory samotných objektov.
Pŕıklad správy

MESSAGE {
SENDER = ’A’
RECEIVER = ’S’
ACTIVE_SETTINGS = ’subprotocol’
ACTION {

SENT_PREACTION = ’’
SENT_POSTACTION = ’’
RECEIVED_PREACTION = ’’
RECEIVED_POSTACTION = ’’

}
ROOT_PAYLOAD {

ID = ’Message 1’
DESCRIPTOR = ’’

}
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COMPONENTS {
TOP_LEVEL: 15042384 15238424

}
}

Po vytvoreńı správ (správanie protokolu) muśıme definovat’ predpoklady a ciele protokolu.
Program pracuje s GNY logikou a defińıcia zahrňuje beliefs a possesions u jednotlivých
účastńıkov ako na strane predpokladov tak na strane ciel’ov. Zápis v zdrojovom súbore je
značne rozsiahly a pracný. Osvedčilo sa mi modelovanie na úrovni GUI. Definovanie GNY
pravidiel prebieha rovnakým postupom ako vytváranie správ. Predpoklady existujú zvlášt’
pre každého účastńıka

• Fresh Components – Aktuálnost’ objektu

• Recognizable Components – Znalosti objektu

• Suitable Public Keys – Znalost’ kl’́učov

• Trustworthy Principals – Dôveryhodný účastńıci

• Jurisdiction – Dôvera v objekt, ktorý je dôveryhodný pre iného účastńıka

• Suitable Secret – Tajomstvo medzi objektami

4.4 Výsledky implementácie

Každý z nástrojov dovol’uje poṕısat’ požadovaný protokol pomocou jazyka. Výnimkou je
nástroj SPEAR 2, ktorý umožňuje modelovanie aj na úrovni GUI. Jazyky sú rôzne ale
majú spoločné rysy. Sémantika je podobná, no odlǐsujú sa hlavne v syntaxi. Základom
v jazyku HLPSL a SPDL sú role a ich popis vrátane správania. Pri jazyku CAS+ naopak
deklarujeme entity a správanie oddelene. Implementácia v SPR zahrňuje hierarchiu objek-
tov (entity, obsah správy, šifrovanie, správa) a GNY pravidlá.

Kedže nástroje sú primárne určené k simulácii bezpečnostných protokolov, ich jazyky pod-
poruju všetky vlastnosti ako sú symetrické/asymetrické šifrovanie (kl’́uče), nonce, časové
známky, . . . . Môžeme pracovat’ s rôznymi rolami (útočńık, server, účastńıci).

AVISPA SPAN Scyther SPEAR 2

Jazyk HLPSL HLPSL, CAS+ SPDL SPR

GUI režim ◦ ◦ ◦ •
Textový režim • • • ◦

Vlastnosti Defińıcia roĺı Popis správania Defińıcia roĺı Popis objektov

Stavový automat Popis ent́ıt GNY logika

ASN.1

◦ - nepodporuje, • - podporuje

Tabulka 4.2: Výsledky porovnania implementácie
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Kapitola 5

Charakteristiky nástrojov

Od spôsobov implementácie prejdem v tejto kapitole ku charakteristikám použ́ıvania jed-
notlivých nástrojov. To zahrňuje najmä spôsoby inštalácie a ovládania.

5.1 AVISPA

5.1.1 Inštalácia

Program existuje v dvoch verziách. Jedna verzia je dostupná pre operačný systém Li-
nux a Mac OS, druhá je dostupná prostredńıctvom internetového prehliadača. Z pohl’adu
inštalácie je jednoduchšie použit’ online verziu. Nevýhodou je závislost’ na internetovom
pripojeńı a dostupnosti služby.

5.1.2 Ovládanie

Použ́ıvatel’ské rozhranie online verzie programu môžeme rozdelit’ na niekol’ko čast́ı: editačné
okno, panel nástrojov, práca so súborom a vol’ba režimu.

Editačné okno Tento panel zastáva viacero funkcíı. V základnom režime zobrazuje
nač́ıtaný protokol. Pre editáciu sa muśıme prepnút’ do editačného režimu (edit). Po do-
končeńı uložit’ (save), č́ım sa opät’ vrátime do základného režimu. Uloženie je nevyhnutné
pre aplikovanie zmien. Poslednou funkciou je stavový a chybový výpis. Ten sa objav́ı po
použit́ı niektorého zo vstavaných nástrojov.

Panel nástrojov Ponuka vstavaných nástrojov pre verifikáciu protokolu (obr. 3.1).

• HLPSL2IF - Prekladač z jazyka HLPSL do ekvivalentného formálneho jazyka IF
(ńızkoúrovňový popis). Prevod je nevyhnutný pre d’al’̌sie spracovanie.

• OFMC - On-the-fly Model-Checker verifikuje protokol skúmańım prechodov ohrani-
čenej session (model), poṕısaných v jazyku IF [24].

• CL-AtSe - Constraint-Logic-based Attack Searcher aplikuje obmedzujúce podmienky
stanoveného počtu session k verifikácíı protokolu [24].

• SATMC - SAT Model-Checker redukuje vstupný problém do sekvencie pre SAT sol-
vers [24].
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• TA4SP - neohraničená verifikácia protokolu aproximovańım útočńıkových znalost́ı
[24].

Práca so súbormi Nač́ıtanie predpripravených alebo vlastných zdrojových súborov.

Režim Vol’ba medzi základným a expertným režimom. Rozdiel spoč́ıva v tom, že v ex-
pertnom režime je dostupný panel nástrojov, zatial’ čo v základnom sa po spusteńı simulácie
zavolajú automaticky všetky vstavané nástroje poč́ınajúc prekladom do IF (obr. 3.1).

Po odsimulovańı dostávame v editačnom okne suhrnný výstup od jednotlivých nástrojov
s výsledokom verifikácie. Zároveň si môžeme u každého nástroja zobrazit’ podrobný výpis
ako aj graficku podobu útoku (časový diagram).

5.2 SPAN

5.2.1 Inštalácia

Nástroj je distribuovaný v štyroch verziách. Binárne verzie pre operačné systémy Windows,
Linux a Mac OS a v podobe zdrojových kódov. Pre svoj behu vyžaduje Tcl/Tk knižnice.

Windows Inštalačný súbor spolu s inštaláciou Tcl/Tk knižnice (vyžadovaná je minimálna
verzia 8.3) je stiahnutel’ný z domovskej stránky programu. Po inštalácii je potrebné pridat’
premennú prostredia (path) smerujúcu na adresár s Tcl/Tk

Path %Path%;C:\PROGRA~1\Tcl\bin

a vytvorit’ novú premennú k adresáru s nástrojom SPAN

SPAN C:\SPAN

Linux Po stiahnut́ı programu z domovskej stránky, stač́ı rozbalit’ obsah do l’ubovolného
adresára. Podobne ako na platforme Windows, požadovaná je pŕıtomnost’ Tcl/Tk (verzia
8.5). Následne stač́ı nastavit’ premenné prostredia (path)

export SPAN=/home/user/span
export AVISPA_PACKAGE=/home/uset/span

5.2.2 Ovládanie

Ako už bolo spomenuté, nástroj vychádza z projektu AVISPA. Jeho základ, vrátane pod-
porných nástrojov (obr. 3.1), je rovnaký. Poskytuje naviac interakt́ıvnu vizualizáciu si-
mulácie protokolu, útoku a útočńıka.

V okne vizualizácie (obr. 5.1) sa na l’avej strane objavujú prichádzajúce udalosti. Po pŕıchode
sa simulácia zastav́ı a môžeme určit’, ktorým smerom bude priebeh pokračovat’. Simuláciu
možno krokovat’ dopredu aj dozadu (Previous step, Next step). Nastavit’ sa dá sledovanie
konkrétnych premenných (účastńıkov, kl’́učov, . . . ). Možeme nastavit’ spôsob zobrazenia
správ, č́ım sprehladńıme sekvenčný diagram. Výsledný diagram môžeme uložit’ a opätovne
nač́ıtat’.
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Obrázek 5.1: Priebeh protokolu – Yahalom protokol

Simulácia útoku a simulácia útočńıka ponúka rovnaké možnosti a rozloženie ovládaćıch
prvkov. Rozdiel je v tom, že môžeme explicitne nastavit’ a nechat’ zobrazit’ útočńıkové ve-
domosti.

Oproti nástroju AVISPA dokáže SPAN nač́ıtat’ protokol v jazyku CAS+ a následne kon-
vertovat’ do jazyka HLPSL. Počas môjho testovania sa u niektorých protokolov vyskytli
problémy pri konverzii. Vo väčšine pŕıpadov prebehla konverzia v poriadku.

5.3 SPEAR 2

5.3.1 Inštalácia

Nástroj je dostupný pre platformu Windows. Inštalačné súbory sú k dispoźıcii na domovskej
stránke projektu. K analýze GNY, program vyžaduje pŕıtomnost’ SWI–Prolog (inštalačný
súbor je rovnako dostupný na stránke projektu). V nastaveniach programu sa muśı vyplnit’
cesta k prologu.

5.3.2 Ovládanie

Program disponuje širokými možnost’ami ovládania. Najväčšiu čast’ okna tvoŕı plocha (ca-
nvas) s časovým diagramom protokolu. Jedná sa o abstraktný pohl’ad na modelovaný pro-
tokol. Na l’avej strane je stručný stromový prehl’ad vytvorených objektov.

Priamo na ploche môžeme cez kontextové menu (Add Canvas Object) vytvorit’ objekty
(účastńık, správa, podprotokol). V dialogu pre vytvorenie nového objektu nastav́ıme do-
datočné vlastnosti ako napr. meno, pŕıjemca, odosielatel’, obsah správy, poradie (obr. 5.2a).
Pri vytvárańı obsahu správy máme na výber vytvorenie nového objektu alebo použitie
existujúcich. Objekty rozdel’ujeme na dve skupiny

• Terminal - nonce, časové raźıtko, zdiel’ané tajomstvo, symetrické/asymetrické kl’́uče.

• Non-terminal - funkcia, hash, symetrické/asymetrické šifrovanie, skupina.
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pričom terminálny objekt nemôže obsahovat’ d’aľsie objekty.

Vyvolańım kontextovej ponuky môžeme správy zmazat’ (Delete), duplikovat’ (Duplicate),
nastavit’ akciu pred/po prijat́ı/odoslańı (obr. 5.2b) alebo zmenit’ vlastnosti (Properties).

Účastńıkovi môžeme pridat’ správu (Add Message) alebo zmenit’ meno (Edit name).

(a) Vlastnosti správy (b) Nastavenie akcie

Obrázek 5.2: Nastavenie správy v SPEAR 2

Objekty môžeme navzájom presúvat’ myšou a menit’ tak ich poradie. Program dokáže
zvýraznit’ konkrétne objekty cez funkciu Design→Component Tracker, čo pomôže pri mo-
delovańı zložitých protokolov. Program dovol’uje vytvorit’ podprotokol v l’ubovolnom mieste.

Najdôležiteǰsia čast’ progamu je GNY analýza protokolu. V jednom dialogovom okne
(GNY→Analyze Protocol), sú všetky potrebné nastavenia. Rovnako ako v pŕıpade vytvá-
rania správy aj tu sú objekty hierarchicky usporiadané.

• Assumptions - predpoklady u jednotlivých účastńıkov (beliefs and possessions), tj.
znalosti pred začiatkom komunikácie.

• Goals - ciel’ové požiadavky (beliefs and possessions) u každého účastńıka.

• Extensions - pripojenie rozš́ırenia vybraným formuliam.

• Analysis - nastavenie ciest k prologu a pracovnému adresáru. Spustenie samotnej
analýzy.

• Result - výsledky analýzy (obr. 5.3b). Prehl’ad a detaily vaĺıdnych a nesprávnych
predpokladov a požiadavkov (beliefs and possessions).

Výsledné pravidlá GNY logiky ako aj formálny popis vytvoreného protokolu, môžeme zob-
razit’ a exportovat’ do textového formátu alebo súboru LATEX. Program dokáže vypoč́ıtat’
synchrónny a optimálny beh protokolu (Calculate Synchronous rounds, Calculate Optimal
rounds).
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(a) Predpoklady (b) Výsledky analázy

Obrázek 5.3: GNY analýza v SPEAR 2

5.4 Scyther

5.4.1 Inštalácia

Program (dostupný na stránkach projektu) je naṕısaný v jazyku Python, čo z neho rob́ı
multi-platformný nástroj. Vyžaduje inštaláciu Python, wxPython a GraphViz (odkazy sú
na stránkach projektu Scyther). Knižnica GraphViz vykresluje grafy.

5.4.2 Ovládanie

Na rozdiel od predchádzajúceho nástroja SPEAR 2, ponúka rozhranie Scyther menej mo-
žnost́ı. Hlavné okno má dve záložky: popis protokolu (Protocol description) a nastavenia
(Settings).

Popis protokolu V tejto záložke môžeme editovat’ protokol. Protokol je poṕısaný v ja-
zyku SPDL. Dôraz je kladený na bezpečnostné požiadavky (claims).

Nastavenia Hlavné nastavenia programu. Ovplyvňujú verifikáciu obmedzeńım počtu be-
hov, maximálnym počtom vzorov a dodatočnými parametrami pre jadro programu. Možnost’
zmenit’ vel’kost ṕısma sa hod́ı najmä pri rozsiahlych protokoloch.

Ak máme výsledný protokol poṕısaný a nastavené hlavné paremetre, môžeme spustit’ ve-
rifikáciu v menu Verify→Verify protocol (F1). Zobraźı sa nám okno (obr. 5.4), kde každý
riadok predstavuje jednu požiadavku (claim). Na riadku je vyṕısaný v porad́ı: názov proto-
kolu, rola (identifikácia účastńıka), identifikátor požiadavky, typ požiadavky a parameter,
stav informujúci o nájdenom útoku, komentár a tlač́ıtko pre grafické zobrazenie útoku.

Často sa stáva, že program nenájde útok a konč́ı s výsledkom No attack within bounds.
Pri verifikačnom procese Scyther prehl’adáva strom všetkých možnost́ı avšak je obmedzený

32



Obrázek 5.4: Výsledky verifikácie – Needham Schroeder protokol

počtom behov (nastavenia programu). Je dôležité zvolit’ vhodnú hodnotu. Pŕılǐs vel’ká hod-
nota znamená viac času potrebného na verifikáciu. Malá hodnota nemuśı nájst’ útok.

Okrem verifikácie si môžeme nechat’ graficky zobrazit’ role cez menu Verify→Characterize
roles (F2). Nové okno má rovnaký obsah ako v pŕıpade verifikácie.

Ak sa rozhodneme zobrazit’ útok alebo niektorú z roĺı, otvoŕı sa nové okno (obr. 5.5).
Hlavnými prvkami sú obd́lžniky spojené š́ıpkami. Š́ıpky reprezentujú poradie. Obd́lžnik
znázorňuje nový beh, udalost’ behu a udalost’ spôsobenú bezpečnostnou podmienkou. Ver-
tikálna os predstavuje beh protokolu (výskyt role).

Obrázek 5.5: Znázornenie útoku – Needham Schroeder protokol
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Kapitola 6

Demonstračné úlohy

Pre d’al’̌sie použitie som ako vhodný nástroj vybral Scyther. Nástroj je vol’ne dostupný.
Vd’aka svojej jednoduchosti a schopnosti vizualizovat’ protokoly (útoky) je vhodnou učebnou
pomôckou. Program dokáže pracovat’ so symetrickými aj asymetrickými verziami protoko-
lov a následne ich verifikovat’. Pŕıpadné útoky nad protokolom zobraźı graficky diagramom.

Obsahom kapitoly bude pre tento nástroj ako aj nástroje SPAN a SPEAR2 naṕısat’ sadu
pŕıkladov a demonstračných úloh. Cvičenia budú vychádzat’ z implementácie protokolov
uvedených v kapitole 4 (Needham-Schroeder Public Key, Yahalom) doplnené o protokoly
Otway Rees a Denning-Sacco Shared Key. Zároveň si kladú za ciel’ zoznámit’ čitatel’a s pro-
blematikou bezpečnostných protokolov, ich simulácie a verifikácie konkrétnym nástrojom.
Tieto úlohy nájdu uplatnenie pri výuke siet’ovo orientovaných predmetov na fakulte FIT
VUT.

6.1 Úloha č.1

Ciel’ úlohy

• Zoznámit’ sa s nástrojom Scyther.

• Vyskúšat’ si implementáciu symetrických a asymetrických bezpečnostných protokolov.

• Vyskúšat’ si verifikáciu bezpečnostných protokolov v nástroji Scyther.

Študijné materiály

• V tejto úlohe bude ciel’om implementovat’ protokoly Needham-Schroeder Public Key,
jeho modifikovanú verziu Lowe, Yahalom, Otway Rees, Denning-Sacco Shared Key
a jeho modifikovanú verziu Lowe.

• Študijné materiály

– Needham-Schroeder Public Key
http://www.lsv.ens-cachan.fr/Software/spore/nspk.html
Gavin Lowe. An attack on the Needham-Schroeder public key authentication
protocol. Information Processing Letters, 56(3):131–136, November 1995.
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– Lowe’s fixed version of Needham-Schroder Public Key
http://www.lsv.ens-cachan.fr/Software/spore/nspkLowe.html
Gavin Lowe. An attack on the Needham-Schroeder public key authentication
protocol. Information Processing Letters, 56(3):131–136, November 1995.

– Yahalom
http://www.lsv.ens-cachan.fr/Software/spore/yahalom.html
Michael Burrows, Martin Abadi, and Roger Needham. A logic of authentication.
Technical Report 39, Digital Systems Research Center, february 1989.

– Otway Rees
http://www.lsv.ens-cachan.fr/Software/spore/otwayRees.html
D. Otway and O. Rees. Efficient and timely mutual authentication. Operating
Systems Review, 21(1):8–10, 1987.

– Denning-Sacco Shared Key
http://www.lsv.ens-cachan.fr/Software/spore/denningSacco.html
D. Denning and G. Sacco. Timestamps in key distributed protocols. Communi-
cation of the ACM, 24(8):533–535, 1981.

– Lowe modifikácia Denning-Sacco Shared Key
http://www.lsv.ens-cachan.fr/Software/spore/denningSaccoLowe.html
Gavin Lowe. A family of attacks upon authentication protocols. Technical Re-
port 1997/5, Department of Mathematics and Computer Science, University of
Leicester, 1997.

Pŕıprava prostredia

• Stiahnite inštalačný súbor z domovskej stránky projektu Scyther:
http://people.inf.ethz.ch/cremersc/scyther/install-windows.html

• Rozbalte stiahnutý arch́ıv do l’ubovolného adresára.

• Stiahnite a nainštalujte knižnicu GraphViz. Aktuálna verzia je dostupná na adrese
http://www.graphviz.org/Download_windows.php.

• Nástroj Scyther je naṕısaný v jazyku Python. Nainštalujte potrebné knižnice Python
a wxPython zo stránok
http://www.python.org/download/
http://www.wxpython.org/download.php.

• Spustite scyther-gui.py z rozbaleného adresára.

• Zavrite okno s informáciami o nástroji.

• Hlavné okno nástroja má dve záložky (Protocol description, Settings). Nechajte akt́ıvnu
záložku Protocol description, v ktorej budeme popisovat’ protokol.

6.1.1 Implementácia Needham-Schroeder Public Key

V tomto pŕıklade si vyskúšate implementáciu a verifikáciu Needham-Schroeder Public Key.

1. V úvode deklarujte globálne premenné. Medzi globálne premenné, tj. premenné vi-
ditel’né všetkým, v našom protokole patŕı public key. V nástroji Scyther sú kl’́uče
deklarované ako funkcie
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1 const pk: Function;
2 secret sk: Function;

kde kl’́učové slovo const znamená, že premenná bude automaticky pridaná k zna-
lostiam útočńıka. Kl’́učové slovo secret naopak zaruč́ı, že premenná nebude patrit’
medzi počiatočné útočńıkové znalosti.

Aký je rozdiel medzi symetrickým a asymetrickým šifrovańım?

2. Verejný a súkromný kl’́uč sú navzájom inverzné. Túto skutočnost’ zaṕı̌ste ako

3 inversekeys(pk,sk);

Ktoré kl’́uče budú použité pri šifrovańı správ medzi entitami A (Alice) a B (Bob)?

3. Definujte protokol pomocou kl’́učového slova protocol

4 protocol NSPK(A,B,S) {

kde A,B,S sú identifikátory role. Zloženú zátvorku ešte neuzatvárajte, pretože budeme
popisovat’ jeho správanie.

4. V rámci protokolu definujte rolu A (Alice) pomocou kl’́učového slova role následova-
ného identifikátorom

5 role A {

5. Každá rola má svoje lokálne premenné. Tieto premenné určujú jej znalosti. V našom
protokole má rola A dve premenné nonce

6 const Na: Nonce;
7 var Nb: Nonce;

kde do premennej Nb bude uložený nonce prijatý od role B.

Aký účel plńı hodnota nonce? Je možné modelovat’ protokol bez tejto hodnoty?

6. Rola má svoje správanie. To zahrňuje posielanie a prij́ımanie správ. Zapisujeme len
správy týkajúce sa konkrétnej roli. Zaṕısat’ muśıme odoslanie aj prijatie. Obecný zápis
má tvar

[‘read’|‘send’] 〈label〉 ( 〈od〉, 〈komu〉, ( 〈term〉[, 〈term〉] ) );

kde 〈label〉 je pomenovanie správy v rámci celkovej komunikácie (odoslanie a prijatie
konkrétnej správy muśı mat’ rovnaké označenie).

Zaṕı̌ste správanie (správy) role A

8 send_1(A,S, (A,B));
9 read_2(S,A, {pk(B),B}sk(S));

10 send_3(A,B, {Na ,A}pk(B));
11 read_6(B,A, {Na ,Nb}pk(A));
12 send_7(A,B, {Nb}pk(B));
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7. Definujte bezpečnostné požiadavky, ktoré má nástroj kontrolovat’. V našom pŕıpade
sa jedná o tajnost’ secret hodnoty nonce

13 claim_A1(A,Secret ,Na);
14 claim_A2(A,Secret ,Nb);

V tomto momente máme definovanú rolu A, nezabudnite uzavriet’ zátvorku

15 }

8. Analogicky na základe krokov 4. až 7. definujte rolu B (Bob)

16 role B {
17 const Nb: Nonce;
18 var Na: Nonce;
19

20 read_3(A,B, {Na ,A}pk(B));
21 send_4(B,S, (B,A));
22 read_5(S,B, {pk(A),A}sk(S));
23 send_6(B,A, {Na ,Nb}pk(A));
24 read_7(A,B, {Nb}pk(B));
25

26 claim_B1(B,Secret ,Nb);
27 claim_B2(B,Secret ,Na);
28 }

9. Definujte rolu servera S. Akú úlohu v tomto protokole plńı server?

29 role S {
30 read_1(A,S, (A,B));
31 send_2(S,A, {pk(B),B}sk(S));
32 read_4(B,S, (B,A));
33 send_5(S,B, {pk(A),A}sk(S));
34 }

V tomto okamihu máme definované správanie protokolu, nezabudnite uzavriet’ zátvorku

35 }

10. Deklarujte účastńıkov ako konštanty typu Agent

36 const Alice ,Bob ,Server ,Compromised: Agent;

11. Na záver deklarujte nedôveryhodného účastńıka (ciel’ útočńıka) a jeho prezradené
informácie

37 untrusted Compromised;
38 const nc: Nonce;
39 compromised sk(Compromised );
40 compromised pk(Compromised );
41 compromised pk(Server );

12. Súbor uložte na disk (napr. NSPK.spdl). Spustite verifikáciu cez menu Verify→Verify
protocol (F1). Nechajte si zobrazit’ útok.
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6.1.2 Implementácia Needham-Schroeder Public Key - Lowe

V predchádzajúcom pŕıklade ste implementovali a odsimulovali nezabezpečenú verziu
Needham-Schroeder PK protokolu. Teraz si vyskúšate implementovat’ jeho modifikovanú
verziu Lowe a porovnáte výsledok.V čom spoč́ıva rozdiel medzi pôvodnou a modifikovanou
verziou?

1. Nač́ıtajte uloženú verziu NSPK.spdl cez menu File→Open

2. Modifikovaná verzia pridáva do správy medzi Bob a Alice v 6. kroku identitu B.
Modifikujte zdrojový súbor tak, aby odpovedal verzii Lowe

11 read_6(B,A, {Na ,Nb ,B}pk(A));

23 send_6(B,A, {Na ,Nb ,B}pk(A));

3. Spustite verifikáciu cez menu Verify→Verify protocol (F1). Porovnajte a diskutujte
zmeny.

6.1.3 Implementácia Yahalom

V tomto pŕıklade si vyskúšate implementáciu protokolu Yahalom, ktorý využ́ıva symetrické
šifrovanie.

1. Deklarujte symetrický kl’́uč ako funkciu. Tento kl’́uč bude tajný a nebude patrit’ medzi
počiatočné útočńıkové znalosti.

1 secret k: Function;

2. Deklarujte nový datový použ́ıvatel’ský typ SessionKey. Tento typ bude určený pre
session kl’́uč.

2 usertype SessionKey;

Aký kl’́uč bude použitý pri šifrovańı správ medzi entitami A (Alice) a B (Bob)?

3. Definujte protokol Yahalom pomocou kl’́učového slova protocol. Protokol bude ob-
sahovat’ role Alice, Bob, Server

3 protocol Yahalom(A,B,S) {

4. V rámci protokolu definujte rolu A (Alice) kl’́učovým slovom role

4 role A {

5. Deklarujte jej lokálne premenné: nonce (Nonce), dosaditel’ný term (ticket) a session
kl’́uč (SessionKey)

5 const Na: Nonce;
6 var Nb: Nonce;
7 var T: Ticket;
8 var Kab: SessionKey;
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6. Poṕı̌ste správanie role A pomocou správ

9 send_1(A,B, A,Na);
10 read_3(S,A, {B,Kab ,Na ,Nb}k(A,S),T);
11 send_4(A,B, T,{Nb}Kab);

7. Deklarujte bezpečnostné požiadavky claims na tajnost’ session kl’́uča

12 claim_A1(A,Secret ,Kab);

v tomto momente máme úplne definovanú rolu A. Uzavrite zloženú zátvorku

13 }

8. Opakujete kroky 4. až 7. a definujte rolu B (Bob)

14 role B {
15 const Nb: Nonce;
16 var Na: Nonce;
17 var T: Ticket;
18 var Kab: SessionKey;
19

20 read_1(A,B, A,Na);
21 send_2(B,S, B,{A,Na ,Nb}k(A,S));
22 read_4(A,B, {A,Kab}k(A,S),{Nb}Kab);
23

24 claim_B1(B,Secret ,Kab);
25 }

9. Podobne ako role A a B definujte poslednú rolu S (Server) Akú úlohu plńı server
v tomto protokole?

26 role S {
27 const Kab: SessionKey;
28 var Na ,Nb: Nonce;
29

30 read_2(B,S, B,{A,Na ,Nb}k(A,S));
31 send_3(S,A, {B,Kab ,Na ,Nb}k(A,S), {A,Kab}k(A,S));
32

33 claim_S1(S,Secret ,Kab);
34 }

v tomto momente máme definované správanie protokolu. Uzavrite zloženú zátvorku

35 }

10. Deklarujte účastńıkov ako typ Agent. Deklarujte nedôveryhodného účastńıka (útočńı-
kov ciel’) a jeho uniknuté informácie

36 const Alice ,Bob ,Server ,Compromised: Agent;
37 untrusted Compromised;
38 compromised k(Compromised ,Server );
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11. Spustite verifikáciu cez menu Verify→Verify protocol (F1) a overte, či existuje do-
stupný útok.

6.1.4 Implementácia Otway Rees

V tomto pŕıklade si vyskúšate implementáciu protokolu Otway Rees, ktorý využ́ıva symet-
rické šifrovanie.

1. Deklarujte symetrický kl’́uč ako funkciu. Tento kl’́uč nebude patrit’ medzi počiatočné
útočńıkové znalosti.

1 secret k: Function;

2. Deklarujte nový datový použ́ıvatel’ský typ SessionKey. Tento typ bude určený pre
session kl’́uč. Zároveň definujte typ ret’azec String

2 usertype String ,SessionKey;

3. Definujte protokol Otway Rees pomocou kl’́učového slova protocol. Protokol bude
obsahovat’ role Alice, Bob, Server

3 protocol OtwayRees(A,B,S) {

4. V rámci protokolu definujte rolu A (Alice) kl’́učovým slovom role

4 role A {

5. Deklarujte jej lokálne premenné nonce, ret’azec String a session kl’́uč SessionKey

5 const Na: Nonce;
6 const M: String;
7 var Kab: SessionKey;

6. Poṕı̌ste správanie role A pomocou správ

8 send_1(A,B, M,A,B,{Na ,M,A,B}k(A,S));
9 read_4(B,A, M,{Na ,Kab}k(A,S));

7. Deklarujte bezpečnostné požiadavky claim na tajnost’ session kl’́uča a synchronizáciu
nonce

10 claim_A1(A,Secret ,Kab);
11 claim_A2(A,Nisynch );

v tomto momente máme úplne definovanú rolu A. Uzavrite zloženú zátvorku

12 }

8. Opakujete kroky 4. až 7. a definujte rolu B (Bob)
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13 role B {
14 var M: String;
15 const Nb: Nonce;
16 var Kab: SessionKey;
17 var T1 ,T2: Ticket;
18

19 read_1(A,B, M,A,B,T1);
20 send_2(B,S, M,A,B,T1 ,{Nb ,M,A,B}k(B,S));
21 read_3(S,B, M,T2 ,{Nb ,Kab}k(B,S));
22 send_4(B,A, M,T2);
23

24 claim_R1(B,Secret ,Kab);
25 claim_R2(B,Nisynch );
26 }

9. Podobne ako role A a B definujte poslednú rolu S (Server). Akú úlohu plńı v tomto
protokole server?

27 role S {
28 var Na ,Nb: Nonce;
29 var M: String;
30 const Kab: SessionKey;
31

32 read_2(B,S, M,A,B,{Na ,M,A,B}k(A,S),{Nb ,M,A,B}k(B,S));
33 send_3(S,B, M,{Na ,Kab}k(A,S),{Nb ,Kab}k(B,S));
34 }

v tomto momente máme definované správanie protokolu. Uzavrite zloženú zátvorku

35 }

10. Deklarujte účastńıkov ako typ Agent. Deklarujte nedôveryhodného účastńıka (útočńı-
kov ciel’) a jeho uniknuté informácie

36 const Alice ,Bob ,Server ,Compromised: Agent;
37 untrusted Compromised;
38 compromised k(Compromised ,Server );

11. Spustite verifikáciu cez menu Verify→Verify protocol (F1) a overte, či existuje do-
stupný útok.

6.1.5 Implementácia Denning-Sacco Shared Key

V tomto pŕıklade si vyskúšate implementáciu protokolu Denning-Sacco Shared Key, ktorý
využ́ıva symetrické šifrovanie.

1. Deklarujte symetrický kl’́uč ako funkciu. Tento kl’́uč nebude patrit’ medzi počiatočné
útočńıkové znalosti

1 secret k: Function;
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2. Deklarujte nový datový typ SessionKey. Tento typ bude určený pre session kl’́uč.
Zároveň deklarujte typ časové raźıtko TimeStamp, ktorý tento protokol použ́ıva

2 usertype SessionKey;
3 usertype TimeStamp;

Aký kl’́uč bude použitý pri šifrovańı správ medzi entitami A (Alice) a B (Bob)?

3. Definujte protokol DenningSacco pomocou kl’́učového slova protocol. Protokol bude
obsahovat’ role Alice, Bob, Server

4 protocol DenningSacco(A,B,S) {

4. V rámci protokolu definujte rolu A (Alice) kl’́učovým slovom role

5 role A {

5. Deklarujte jej lokálne premenné: časové raźıtko (TimeStamp), dosaditel’ný term (Ticket)
a session kl’́uč (SessionKey)

6 var W: Ticket;
7 var Kab: SessionKey;
8 var T: TimeStamp;

Aký význam má použitie časového raźıtka?

6. Poṕı̌ste správanie role A pomocou správ

9 send_1(A,S, A,B);
10 read_2(S,A, {B,Kab ,T,W}k(A,S));
11 send_3(A,B, W);

7. Deklarujte bezpečnostné požiadavky claim na tajnost’ session kl’́uča a synchronizáciu
nonce. Sledovanie synchronizácie umožńı odhalit’ replay útok

12 claim_A1(A,Nisynch );
13 claim_A2(A,Secret ,Kab);

v tomto momente máme úplne definovanú rolu A. Uzavrite zloženú zátvorku

14 }

8. Podl’a krokov 4. až 7. definujte rolu B (Bob)

15 role B {
16 var Kab: SessionKey;
17 var T: TimeStamp;
18

19 read_3(A,B, {Kab ,A,T}k(B,S));
20

21 claim_B1(B,Nisynch );
22 claim_B2(B,Secret ,Kab);
23 }
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9. Podobne ako role A a B definujte poslednú rolu S (Server). Akú úlohu plńı server
v tomto protokole?

24 role S {
25 var W: Ticket;
26 const Kab: SessionKey;
27 const T: TimeStamp;
28

29 read_1(A,S, A,B);
30 send_2(S,A, {B,Kab ,T,{Kab ,A,T}k(B,S)}k(A,S));
31 }

v tomto momente máme definované správanie protokolu. Uzavrite zloženú zátvorku

32 }

10. Deklarujte účastńıkov ako typ Agent. Deklarujte nedôveryhodného účastńıka (útočńı-
kov ciel’) a uniknuté informácie

33 const Alice ,Bob ,Server ,Compromised: Agent;
34 compromised k(Compromissed ,Server );

11. Súbor uložte na disk (napr. DSSK.spdl). Spustite verifikáciu cez menu Verify→Verify
protocol (F1) a overte, či existuje dostupný útok.

6.1.6 Implementácia Denning-Sacco Shared Key - Lowe

V predchádzajúcom pŕıklade ste implementovali a odsimulovali nezabezpečenú verziu
Denning-Sacco SK protokolu. Teraz si vyskúšate implementovat’ jeho modifikovanú verziu
Lowe a porovnáte výsledok. V čom spoč́ıva rozdiel oproti pôvodnej verzíı?

1. Nač́ıtajte uloženú verziu DSSK.spdl cez menu File→Open

2. Modifikovaná verzia upravuje protokoly tak, aby využ́ıvali nonce. Zároveň pridáva
funkciu dekrementácie. Modifikujte zdrojový súbor tak, aby odpovedal verzii Lowe

Modifikácia vyžaduje deklaráciu nového datového typu PseudoFunction na globálnej
úrovni. Jej správanie nieje nutné explicitne vyjadrit’

4 usertype PseudoFunction;
5 const dec: PseudoFunction;

Ďalej upravte správanie roĺı tak, aby odpovedalo modifikácíı Lowe. Nezabudnite de-
klarovat’ lokálnu premennú nonce

11 var Nb: Nonce;

23 const Nb: Nonce;

15 read_4(B,A, {Nb}Kab);
16 send_5(A,B, {{Nb}dec}Kab);
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26 send_4(B,A, {Nb}Kab);
27 read_5(A,B, {{Nb}dec}Kab);

3. Spustite verifikáciu cez menu Verify→Verify protocol (F1). Porovnajte a diskutujte
zmeny.

6.2 Úloha č.2

Ciel’ úlohy

• Zoznámit’ sa s nástrojom SPAN.

• Vyskúšat’ si implementáciu symetrických a asymetrických bezpečnostných protokolov.

• Vyskúšat’ si verifikáciu bezpečnostných protokolov v nástroji SPAN.

Študijné materiály

• V tejto úlohe bude ciel’om implementovat’ protokoly Needham-Schroeder Public Key,
Yahalom a protokol Denning-Sacco Shared Key.

• Študijné materiály

– Needham-Schroeder Public Key
http://www.lsv.ens-cachan.fr/Software/spore/nspk.html
Gavin Lowe. An attack on the Needham-Schroeder public key authentication
protocol. Information Processing Letters, 56(3):131–136, November 1995.

– Yahalom
http://www.lsv.ens-cachan.fr/Software/spore/yahalom.html
Michael Burrows, Martin Abadi, and Roger Needham. A logic of authentication.
Technical Report 39, Digital Systems Research Center, february 1989.

– Denning-Sacco Shared Key
http://www.lsv.ens-cachan.fr/Software/spore/denningSacco.html
D. Denning and G. Sacco. Timestamps in key distributed protocols. Communi-
cation of the ACM, 24(8):533–535, 1981.

Pŕıprava prostredia

• Stiahnite a nainštalujte knižnicu Tcl/Tk. Aktuálna verzia je dostupná na adrese
http://sourceforge.net/projects/tcl/files/Tcl/8.3.2/tcl832.exe/download.

• Stiahnite inštalačný súbor z domovskej stránky projektu SPAN a spustite inštaláciu:
http://www.irisa.fr/celtique/genet/span/

• Spustite span.exe z adresára aplikácie.
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6.2.1 Implementácia Needham-Schroeder Public Key

V tomto pŕıklade si vyskúšate implementáciu a verifikáciu Needham-Schroeder Public Key.

1. Po spusteńı nástroja zadávajte kód protokolu v hlavnej editovacej časti okna.

2. Na úvod deklarujte protokol kl’́učovým slovom protocol nasledovaným jeho menom

1 protocol NeedhamSchroederPublicKey;

3. Nasleduje deklarácia identifikátorov (premenných). Obecný zápis premennej má tvar

nazov : typ;

Deklarujte účastńıkov (user), nonce (number) a verejné kl’́uče (public key) ako pre-
menné

2 identifiers
3 A,B,S : user;
4 Na,Nb : number;
5 KPa ,KPb ,KPs : public_key;

4. V d’al’̌sej časti definujte správanie protokolu pomocou správ. Správy majú obecný tvar

N.[od]→ [komu] : obsah, [{sifrovany obsah}kluc]

kde N = 1..k.

6 messages
7 1. A -> S : A,B
8 2. S -> A : {KPb , B}KPs ’
9 3. A -> B : {Na , A}KPb

10 4. B -> S : B,A
11 5. S -> B : {KPa , A}KPs ’
12 6. B -> A : {Na , Nb}KPa
13 7. A -> B : {Nb}KPb

kde ’ znač́ı súkromný kl’́uč.

5. Po dokončeńı popisu správ správania deklarujte znalosti jednotlivých účastńıkov

14 knowledge
15 A : A,B,S,KPa ,KPb ,KPs;
16 B : A,B,S,KPa ,KPb ,KPs;
17 S : A,B,S,KPa ,KPb ,KPs;

6. Kedže nástroj umožňuje pracovat’ s viacerými výskytmi protokolu súčasne, je potrebné
priradit’ k jednotlivým premenným konkrétne hodnoty. V časti session instances
prirad’te identifikátorom z kroku 3 konkrétne hodnoty

18 session_instances
19 [A:alice ,B:bob ,S:server ,KPa:pk1 ,KPb:pk2 ,KPs:pk3];
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7. V časti intruder knowledge definujte počiatočné znalosti útočńıka

20 intruder_knowledge
21 alice ,bob ,pk1 ,pk3;

8. Na záver v časti goal definujte bezpečnostné požiadavky protokolu. V našom pŕıpade
sa jedná o autentifikáciu účastńıkov pomocou nonce

22 goal
23 A authenticates B on Na;
24 B authenticates A on Nb;

9. Uložte protokol v jazyku CAS+. Kedže nástroj pracuje s jazykom HLPSL, auto-
maticky pri uložeńı (nač́ıtańı) ponúkne konverziu do tohto formátu. Potvrd’te vol’bu
’Yes’.

10. V dolnej časti okna vyberte najprv nástroj OFMC potom ATSE, spustite verifikáciu
a zistite, či existuje k danému protokolu útok. Pŕıpadný útok si nechajte vizualizovat’.

6.2.2 Implementácia Yahalom

V tomto pŕıklade si vyskúšate implementáciu protokolu Yahalom, ktorý využ́ıva symetrické
šifrovanie.

1. Po spusteńı nástroja zadávajte kód protokolu v hlavnej editovacej časti okna.

2. Na úvod deklarujte protokol kl’́učovým slovom protocol nasledovaným jeho menom

1 protocol Yahalom;

3. Nasleduje deklarácia identifikátorov (premenných). Pripomeňme, že obecný zápis pre-
mennej má tvar

nazov : typ;

Deklarujte účastńıkov (user), nonce (number) a verejné kl’́uče (public key) ako pre-
menné

2 identifiers
3 A,B,S : user;
4 Na,Nb : number;
5 KPa ,KPb ,KPs : public_key;

4. V d’al’̌sej časti definujte správanie protokolu pomocou správ

6 messages
7 1. A -> B : A,Na
8 2. B -> S : B,{A,Na ,Nb}Kbs
9 3. S -> A : {B,Kab ,Na ,Nb}Kas ,{A,Kab}Kbs

10 4. A -> B : {A,Kab}Kbs ,{Nb}Kab

5. Po dokončeńı popisu správ správania deklarujte počiatočné znalosti jednotlivých ú-
častńıkov
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11 knowledge
12 A : A,B,S,Kas;
13 B : B,S,Kbs;
14 S : S,A,B,Kas ,Kbs;

6. Nástroj umožňuje pracovat’ s viacerými výskytmi protokolu súčasne, je potrebné prira-
dit’ k jednotlivým premenným konkrétne hodnoty. V časti session instances preto
prirad’te identifikátorom z kroku 3 konkrétne hodnoty

15 session_instances
16 [A:alice ,B:bob ,S:server ,Kas:key1 ,Kbs:key2];

7. Na záver v časti goal definujte bezpečnostné požiadavky protokolu. V našom pŕıpade
sa jedná o tajnost’ session kl’́uča

17 goal
18 secrecy_of Kab [];

8. Uložte protokol v jazyku CAS+. Kedže nástroj pracuje s jazykom HLPSL, auto-
maticky pri uložeńı (nač́ıtańı) ponúkne konverziu do tohto formátu. Potvrd’te vol’bu
’Yes’.

9. V dolnej časti okna vyberte najprv nástroj OFMC potom ATSE, spustite verifikáciu
a zistite, či existuje k danému protokolu útok.

6.2.3 Implementácia Denning-Sacco Shared Key

V tomto pŕıklade si vyskúšate implementáciu a verifikáciu Denning-Sacco Shared Key. Na
akom šifrovańı je založený protokol?

1. Na úvod deklarujte protokol kl’́učovým slovom protocol nasledovaným jeho menom.

1 protocol DenningSaccoSharedKey;

2. Nasleduje deklarácia identifikátorov (premenných). Ako bolo spomenuté, obecný zápis
premennej má tvar

nazov : typ;

Deklarujte účastńıkov (user), nonce (number) a symetrické kl’́uče (symmetric key)
ako premenné

2 identifiers
3 A,B,S : user;
4 T : number;
5 Kas ,Kbs ,Kab : symmetric_key;

3. V d’al’̌sej časti definujte správanie protokolu pomocou správ. Aké kl’́uče budú použité
pre šifrovanie komunikácie?

6 messages
7 1. A -> S : A,B
8 2. S -> A : {B,Kab ,T,{Kab ,A,T}Kbs}Kas
9 3. A -> B : {Kab ,A,T}Kbs
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4. Po dokončeńı popisu správania deklarujte počiatočné znalosti jednotlivých účastńıkov.

10 knowledge
11 A : A,B,S;
12 B : A,B,S;
13 S : A,B,S;

5. Kedže nástroj umožňuje pracovat’ s viacerými výskytmi protokolu súčasne, je po-
trebné priradit’ k jednotlivým premenným konkrétne hodnoty. Prirad’te preto v časti
session instances identifikátorom z kroku 3 konkrétne hodnoty

14 knowledge
15 session_instances
16 [A:alice ,B:bob ,S:server ,Kas:key1 ,Kbs:key2];

6. Na záver v časti goal definujte bezpečnostné požiadavky protokolu. V našom pŕıpade
sa jedná o tajnost’ session kl’́uča

17 goal
18 secrecy_of Kab [];

7. Uložte protokol v jazyku CAS+. Kedže nástroj pracuje s jazykom HLPSL, auto-
maticky pri uložeńı (nač́ıtańı) ponúkne konverziu do tohto formátu. Potvrd’te vol’bu
’Yes’.

8. V dolnej časti okna vyberte najprv nástroj OFMC potom ATSE, spustite verifikáciu
a zistite, či existuje k danému protokolu útok. Pŕıpadný útok si nechajte vizualizovat’.

6.3 Úloha č.3

Ciel’ úlohy

• Zoznámit’ sa s nástrojom SPEAR 2.

• Vyskúšat’ si implementáciu symetrických a asymetrických bezpečnostných protokolov.

• Vyskúšat’ si verifikáciu bezpečnostných protokolov v nástroji SPEAR 2.

Študijné materiály

• V tejto úlohe bude ciel’om implementovat’ protokoly Needham-Schroeder Public Key
a Yahalom.

• Študijné materiály

– Needham-Schroeder Public Key
http://www.lsv.ens-cachan.fr/Software/spore/nspk.html
Gavin Lowe. An attack on the Needham-Schroeder public key authentication
protocol. Information Processing Letters, 56(3):131–136, November 1995.

– Yahalom
http://www.lsv.ens-cachan.fr/Software/spore/yahalom.html
Michael Burrows, Martin Abadi, and Roger Needham. A logic of authentication.
Technical Report 39, Digital Systems Research Center, february 1989.
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Pŕıprava prostredia

• Stiahnite a nainštalujte SWI-Prolog z adresy
http://www.swi-prolog.org/download/stable/bin/w32pl583.exe

• Stiahnite inštalačný súbor z domovskej stránky projektu a spustite inštaláciu
http://www.cs.uct.ac.za/Research/DNA/SPEAR2/index.html

• Spustite Spear2.exe z adresára aplikácie.

6.3.1 Implementácia Needham-Schroeder Public Key

V tomto pŕıklade si vyskúšate implementáciu a verifikáciu Needham-Schroeder Public Key.

1. Po spusteńı aplikácie si môžte všimnút’, že okno je rozdelené na dve časti. V l’avej časti
je stromový prehl’ad objektov. V pravej časti (canvas) sú tieto objekty usporiadane
do časového diagramu. V hlavnom menu aplikácie sa nachádzajú všetky potrebné
nástroje.

2. Na úvod pridajte účastńıkov A (Alice), B (Bob) a S (Server) cez menu

Design→ AddCanvasObject→ Principal (Ctrl + P )

3. V d’al’̌som kroku pridajte prvú správu cez menu

Design→ AddCanvasObject→Message (Ctrl +M)

4. V dialógovom okne pre novú správu nastavte pŕıjemcu a odosielatel’a. Dialógové okno
nezatvárajte, budeme pridávat’ objekty do správy.

5. Prvá správa Needham-Schroeder protokolu obsahuje iba dve entity A a B. Pravým
tlač́ıtkom nad panelom Message Components pridajte existujúcich účastńıkov

Add→ Existing → Component→ A

Add→ Existing → Component→ B

6. Podl’a krokov 2. až 5. pridajte d’al’̌sie správy podl’a špecifikácie protokolu. Objekty
správy, ktoré ešte neboli vytvorené, vytvorte priamo v dialógovom okne pre novú
správu

Add→ New → [typ objektu]

Obdobným spôsobom funguje pridanie šifrovaného obsahu, kedy najprv vytvoŕıme
objekt Public/Private Encryption

Add→ New → Public/Private Encryption

a následne pridáme v rámci tohto objektu obsah (podobne ako pri správe). Na záver
uprav́ıme vlastnosti objektu Encryption (konkrétne Edit Key), kde vṕı̌seme identi-
fikátor objektu (napr. a) komu kl’́uč patŕı.

Poradie správ možno dodatočne menit’ vo vlastnostiach správy, pŕıpadne interakt́ıvne
myšou v hlavnom okne v časovom diagrame.
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7. Po dokončeńı skontrolujte v časovom diagrame či modelovaný protokol odpovedá
špecifikácíı.

8. Teraz potrebujete definovat’ bezpečnostné predpoklady (beliefs, proofs) GNY logiky
cez menu

GNY → Initial Assumptions (Ctrl +Alt+A)

Predpoklady existujú zvlášt’ pre každého účastńıka. Podobne ako pri vytvárańı správy,
pravým tlač́ıtkom myši v záložke Assumptions pridajte postupne objekty

• Fresh Components – Aktuálnost’ objektu

• Recognizable Components – Znalosti objektu

• Suitable Public Keys – Znalost’ kl’́učov

• Trustworthy Principals – Dôveryhodný účastńıci

• Jurisdiction – Dôvera v objekt, ktorý je dôveryhodný pre iného účastńıka

• Suitable Secret – Tajomstvo medzi objektami

9. Na záver rovnako ako v kroku 7, definujte bezpečnostné ciele protokolu

GNY → Intended Goals (Ctrl +Alt+G)

Predpoklady sa rovnako pridávajú zvlášt’ pre každého účastńıka. Pridajte postupne
objekty.

10. Spustite analýzu protokolu cez menu

GNY → Analyze Protocol | Analyze (Ctrl +Alt+ Z)

Po dokončeńı analýzy sa prepnite do záložky Result. Diskutujte zistené poznatky.

6.3.2 Implementácia Yahalom

V tomto pŕıklade si vyskúšate implementáciu a verifikáciu Yahalom.

1. Po spusteńı aplikácie si môžte všimnút’, že okno je rozdelené na dve časti. V l’avej časti
je stromový prehl’ad objektov. V pravej časti (canvas) sú tieto objekty usporiadane
do časového diagramu. V hlavnom menu aplikácie sa nachádzajú všetky potrebné
nástroje.

2. Na úvod pridajte účastńıkov A (Alice), B (Bob) a S (Server) cez menu

Design→ AddCanvasObject→ Principal (Ctrl + P )

3. V d’al’̌som kroku pridajte prvú správu cez menu

Design→ AddCanvasObject→Message (Ctrl +M)

4. V dialógovom okne pre novú správu nastavte pŕıjemcu a odosielatel’a. Dialógové okno
nezatvárajte, budeme pridávat’ objekty do správy.
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5. Prvá správa Yahalom protokolu obsahuje entitu A a objekt nonce. Pravým tlač́ıtkom
nad panelom Message Components pridajte existujúcich účastńıkov

Add→ Existing → Component→ A

Add→ New → Nonce

6. Podl’a krokov 2. až 5. pridajte d’al’̌sie správy podl’a špecifikácie protokolu. Objekty
správy, ktoré ešte neboli vytvorené, vytvorte priamo v dialógovom okne pre novú
správu

Add→ New → [typ objektu]

Obdobným spôsobom funguje pridanie šifrovaného obsahu, kedy najprv vytvoŕıme
objekt Public/Private Encryption

Add→ New → Public/Private Encryption

a následne pridáme v rámci tohto objektu obsah (podobne ako pri správe). Na záver
uprav́ıme vlastnosti objektu Encryption (konkrétne Edit Key), kde vṕı̌seme identi-
fikátor objektu (napr. a) komu kl’́uč patŕı.

Poradie správ možno dodatočne menit’ vo vlastnostiach správy, pŕıpadne interakt́ıvne
myšou v hlavnom okne v časovom diagrame.

7. Po dokončeńı skontrolujte v časovom diagrame či modelovaný protokol odpovedá
špecifikácíı.

8. Teraz potrebujete definovat’ bezpečnostné predpoklady (beliefs, proofs) GNY logiky
cez menu

GNY → Initial Assumptions (Ctrl +Alt+A)

Predpoklady existujú zvlášt’ pre každého účastńıka. Podobne ako pri vytvárańı správy,
pravým tlač́ıtkom myši v záložke Assumptions pridajte postupne objekty

• Fresh Components – Aktuálnost’ objektu
• Recognizable Components – Znalosti objektu
• Suitable Public Keys – Znalost’ kl’́učov
• Trustworthy Principals – Dôveryhodný účastńıci
• Jurisdiction – Dôvera v objekt, ktorý je dôveryhodný pre iného účastńıka
• Suitable Secret – Tajomstvo medzi objektami

9. Na záver rovnako ako v kroku 7, definujte bezpečnostné ciele protokolu

GNY → Intended Goals (Ctrl +Alt+G)

Predpoklady sa rovnako pridávajú zvlášt’ pre každého účastńıka. Pridajte postupne
objekty.

10. Spustite analýzu protokolu cez menu

GNY → Analyze Protocol | Analyze (Ctrl +Alt+ Z)

Po dokončeńı analýzy sa prepnite do záložky Result. Diskutujte zistené poznatky.
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6.4 Zhrnutie

Demonstračné úlohy pozostávajú z implementácie protokolov Needham-Schroeder Public
Key, Needham-Schroeder Public Key - Lowe, Yahalom, Denning-Sacco Shared Key, Denning-
Sacco Shared Key - Lowe a Otway Rees. Na nich si možno vyskúšat’ modelovanie syme-
trického aj asymetrického šifrovania. Zároveň niektoré protokoly obsahujú zranitel’nosti.
Medzi úlohy som sa rozhodol okrem nástroja Scyther zaradit’ aj d’al’̌sie. Konkrétne sa jedná
o nástroje SPAN a SPEAR 2.
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Kapitola 7

Záver

Ciel’om tejto práce bolo zoznámit’ sa s prinćıpmi a použit́ım komunikačných protokolov,
konkrétne bezpečnostných protokolov. Zároveň sa zoznámit’ s dostupnými nástrojmi a pro-
strediami pre interakt́ıvnu simuláciu komunikácie, tieto nástroje vzájomne porovnat’ a na-
ṕısat’ ich vlastnosti.

V druhej kapitole som sa venoval teoretickému úvodu do problematiky bezpečnostných
protokolov, zameral sa na ich vlastnosti, funkcie a možné typy útokov. Rovnako som sa
venoval výrazovým prostriedkom pre ich popis. V tretej kapitole som predstavil vybrané
nástroje. Hlavným kritériom pre výber bola schopnost’ interakt́ıvne simulovat’ bezpečnostné
protokoly. Pri každom nástroji som poṕısal jeho vlastnosti a parametre a snažil sa zhrnút’
jeho výhody resp. nevýhody do niekol’kých bodov. Následne som jednotlivé nástroje porov-
nal z pohl’adu implementácie a naṕısal použ́ıvatel’skú pŕıručku. Na záver som navrhol sadu
demonstračných úloh a pŕıkladov.

Každý z nástrojov uvedený v tejto práci s výnimkou NS2 je schopný simulovat’ a verifikovat’
bezpečnostné protokoly. Okrem GRASP sú ostatné nástroje vol’ne dostupné. Vyznačujú sa
vlastnými jazykmi pre popis protokolov a prostred́ım pre simuláciu. Špecifický je aj pŕıstup
k modelovaniu protokolov. Nástroje AVISPA a SPAN zakladajú na modelovańı stavového
automatu, Scyther vyžaduje defińıciu roĺı a SPEAR2 popisuje objekty a využ́ıva GNY lo-
giku pre počiatočné a ciel’ové požiadavky. V jednotlivých nástrojoch som implementoval
zvolené bezpečnostné protokoly a navrhol sadu demonstračných úloh. Tieto úlohy si kladú
za ciel’ zoznámit’ čitatel’a s problematikou modelovania a verifikácie bezpečnostných proto-
kolov. Zároveň demonštrujú možnosti a špecifické spôsoby implementácie. Výsledky práce
ako aj vytvorené úlohy, nájdu uplatnenie v siet’ovo orientovaných predmetoch na FIT VUT.
Za vhodný nástroj pre tento účel považujem Scyther, ktorý sa vyznačuje jednoduchost’ou
modelovania a zároveň sṕlňa všetky požiadavky na simuláciu a verifikáciu bezpečnostných
protokolov.

Ďal’̌sie pokračovanie práce by spoč́ıvalo v aktualizovańı a doplneńı zoznamu nástrojov. Rov-
nako je možné rozš́ırit’ demonstračné úlohy o d’al’̌sie protokoly a úlohy.
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Dodatek A

Obsah CD

• \doc

– \thesis - Text diplomovej práce vo formáte PDF

– \practice - Demonstračné úlohy vo formáte PDF

• \src

– \text - Zdrojový text diplomovej práce vo formáte LATEX

– \practice - Zdrojový text demonstračných úloh vo formáte LATEX a Microsoft
word 2007+

– \protocols - Zdrojové súbory vybraných bezpečnostných protokolov

• \tools

– \scyther - Aktuálna verzia nástroja Scyther vrátane podporných knižńıc
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